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Introduction

In this chapter, you can find information about the intended use, the addressed
target group, and information about safety and privacy related topics.

Intended Use

ETAS Cloud-Services is a cloud-based platform intended for virtualization pur-
poses by providing a toolchain for continuous integration, test, and validation of
software in automotive electrical/electronic (e/e) systems.

With ETAS MODEL-SIMULATOR, it is possible to run simulations or automated test
executions in the cloud in order to significantly speed up this process in par-
ticular for large simulation and test tasks. As a result, simulation or test execution
results can be downloaded. The results of the simulation depend on the quality
of the plant models and software models as well as on the choice of suitable
excitation signals (input stimuli), quality and representativeness of test pro-
cedures for the intended development task. The results should therefore be
checked for suitability for subsequent investigations by the user.

ETAS Cloud-Services runs in a native cloud environment and is offered as a ser-
vice (SaaS). ETAS GmbH cannot be made liable for damage which is caused by
incorrect use and not adhering to the safety information

ETAS MODEL-SIMULATOR CLI allows you to run the test executions in the cloud.
The CLI can be installed on the local PC or can be integrated into automation
scripts. Currently only Windows is supported.

Target Group

This product is directed at trained qualified personnel in the simulation and cali-
bration sector of powertrain ECUs (e.g. calibration engineer, function developer
or simulation model developer). Technical knowledge in simulation of vehicle sys-
tems and control unit engineering as well as pre-calibration or calibration of
those is a prerequisite.

Data Protection

If the product contains functions that process personal data, legal requirements
of data protection and data privacy laws shall be complied with by the customer.
As the data controller, the customer usually designs subseqguent processing.
Therefore, he must check if the protective measures are sufficient.

Technical and Organizational Measures

This service itself does not encrypt neither the personal data nor data categories
that it records. Ensure that the data downloaded is secured by means of suitable
technical or organizational measures in your own IT system.
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Data and Information Security

To securely handle data in the context of this product, see the next sections
about data and storage locations as well as technical and organizational meas-
ures.

Data and Storage Locations

The following sections give information about data and their respective storage
locations for various use cases.

License Management

When using the ETAS License Manager in combination with user-based licenses
that are managed on the FNP license server within the customer's network, the
following data are stored for license management purposes:

Data
— Communication data: IP address
— User data: Windows user ID
Storage location
— FNP license server log files on the customer network

When using the ETAS License Manager in combination with host-based licenses
that are provided as FNE machine-based licenses, the following data are stored
for license management purposes:

Data
— Activation data: Activation ID
» Used only for license activation, but not continuously during license
usage
Storage location
— FNE trusted storage
C:\ProgramData\ETAS\FlexNet\fne\license\ts

Technical and Organizational Measures

We recommend that your IT department takes appropriate technical and organ-
izational measures, such as classic theft protection and access protection to
hardware and software.



About MODEL-SIMULATOR

ETAS Cloud-Services is a highly secured cloud-based platform, operated by ETAS
GmbH. One of the offered services within this platform is a MODEL-SIMULATOR
service, that enables massive parallelization of simulations with up to 1000 sim-
ulations in parallel. This massive parallelization of simulations allows many sim-
ulations within short time and thus increases software development efficiency
for model based developments. Furthermore, massive parallelization of sim-
ulations enables statistical evaluation of systems.

The MODEL-SIMULATOR supports the simulation of models, that are generated
with the ETAS product COSYM. Basically, these models can be open-loop or
closed-loop models. Simulations can be triggered by combining a simulation
model with a test scenario (campaign) within a project.

After successful simulation, the simulation outputs are aggregated in a report
and can be downloaded for analysis. Besides a report, the MODEL-SIMULATOR
provides simulation results for download.

@ Note

MODEL-SIMULATOR V3.0 is released with the CLI client V2.0.0.

Features at a Glance
— up to 1000 simulations in parallel

— allows simulation of complex systems like vehicle networks, consisting of
virtual vehicle control units, vehicle buses and simulation models

— measurement of 1000 signals within every simulation run
— generating simulation results
— generating reports based on customized report layout

— highly secured cloud environment by fulfillment of information security
standards according to ISO/IEC 27000 & 27001

— support of third party test automation tool ECU-Test for test executions
— Support of COSYM and VLAB as simulators

Use Cases
— statistical evaluation of (complex) system models

— parameter studies with separate parametersets for simulations on simu-
lation run level

— determination of the probability of failure against the development target

— time-efficient execution of (large) software testing tasks, e.g. regression
tests in the DevOps work mode



Depenencies/Licenses
The uploaded artifacts should not contain:
— any reference to external libraries/dependencies

— any artifacts (e.g. FMUs/VECUs) which are needing additional licenses

@ Note

If you are using VECU-BUILDER, then use Go License for your artifacts.
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Basics of MODEL-SIMULATOR

In this chapter, you find descriptions of the basic concepts of the MODEL-
SIMULATOR to get an understanding of the service. It describes the typical work-
flow and its elements more detailed.

@ Note

If you want to start right away, check "Getting Started” on page 44 and "Work-
ing with MODEL-SIMULATOR" on page 52.

Service Basics

The MODEL-SIMULATOR enables the user to execute simulations in the cloud.
Models and stimuli files are used as input, result files and reports are the output.

Input Output
Result
Files
Stimuli

For this procedure the user has to create a project which consists of a simulation
model and one or more campaigns. A campaign is integrated in a test execution
group within a project. The user can download the report, see 3.1.

The MODEL-SIMULATOR provides a model repository, where users can upload
and manage simulation models. It also provides a Campaigns overview, where all
campaigns can be uploaded and managed. In addition, users can upload a report
template to create a customized report according to used signals.

Major elements of the MODEL-SIMULATOR are simulation models (models) and
stimuli files (campaigns), which are brought together in a project.

Workflow

The typical workflow in the MODEL-SIMULATOR is designed in the following
steps, seein Fig. 3-1.
1. Create a model by uploading simulation model.

2. Create a campaign by uploading stimuli files for simulation or test exe-
cution.

MODEL-SIMULATOR V3.0 - User Guide



Create &
Upload

Model

3 Basics of MODEL-SIMULATOR 112

3. Optional: Create areport template by uploading an EATB template (if not
already available).

4. Create a project by selecting one model from the model repository and a
default report template.

Add a test execution group to project by selecting campaigns.
Run the test execution in the project.

Wait until the test executions are completed.

© ~N O o

Download the report (*.html) ortest execution results (*.zip).

Start Simulation in Download Report or

Create & Add Slmulgtlon group Simulation project Simulation results

or or
Upload Create Test execution group Test execution in Test Test execution results
Campaign Project to Project execution project

—\ 0 (® New simulation group
B® > e ® D
- - @ New test execution group

3.3

3.3.1

Fig. 3-1: Overview workflow steps in the MODEL-SIMULATOR

For further information see:
— 5 "Working with MODEL-SIMULATOR" on page 52
— 5.9.3"Required Preprocessing Steps for Models” on page 78
— 5.8.2"Required Preprocessing Steps for Campaigns” on page 67

Projects

The Projects section in the MODEL-SIMULATOR provides the possibility to man-
age simulations and test executions. Within a project models and campaigns are
combined to run simulations or test executions. In addition results and reports
can be downloaded for further analysis or tests.

Projects

Projects are used to create and manage individual automated software tests. To
assign one or multiple campaigns to a project, a new test execution group has to
be created. In a project simulation models and test configuration files are com-
bined to run the test execution in the cloud. The automated test procedure is cre-
ated with a test automation software (e.g. ECU-Test).

Features Overview
The MODEL-SIMULATOR offers the following activities:
— Create, start or stop test executions of project on different levels:
* testexecution groups
» testexecution jobs
» testexecutionruns

see 3.3.2 "Test Executions” on the next page

MODEL-SIMULATOR V3.0 - User Guide
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— Create or delete test execution group, test execution job and test exe-
cution run

— Check test execution (see 3.11 "Overview of Status Labels" on page 35)

— Download test execution results on different levels:
» testexecution groups as *.zip

» testexecution jobs as *.zip
* testexecutionrunsas *.zip
— Search or sort projects
— Edit Project details (project name, description)

For instructions see chapter 5 "Working with MODEL-SIMULATOR" on page 52
and subchapter 5.7 "Projects” on page 59.

Test Executions

During test executions, control mechanisms are applied to run the simulation so
that the concept is not time-driven but event-driven. This means that events
such as "engine on" lead to the next control step, e.g. "switch on ignition”. Suit-
able controls must be implemented in the model.

Test executions can be run by combining one model with one or more test exe-
cution campaign within a project. The executions are part of the project, which
allows the user to run many test executions by assigning campaigns to the pro-
ject. To assign campaigns, test execution groups have to be created.

Test executions are represented by the test execution groups within a project.
The test execution can be based on one or multiple test execution groups, which
are based on one ore multiple test execution jobs (campaigns). The test exe-
cution jobs itself are based on one or multiple test execution runs (test units).
The structure is depicted in Fig. 3-2.

MODEL-SIMULATOR V3.0 - User Guide
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________________

Fig. 3-2: Structure of simulation hierarchy

This test execution hierarchy with group, job and run level allows a flexible use.
On every level test executions can be triggered and results can be downloaded.

The test execution group is the highest hierarchy level. By triggering a test exe-
cution on this level, all the test executions with all nested elements will be
executed. Starting a test execution on any level will lead to costs.

Estimated Time and Estimated Costs of Test executions

Estimated time and estimated costs are shown in a pop-up right before starting a
test execution. Due to the event-driven control of the simulation, the duration of
the simulation is highly dependent on the behavior of the model. So, an estim-
ation of the duration is not possible in advance. Therefore, the user can only be
informed which costs (cloud computation hours) will arise depending on the exe-
cution period. It is recommended to observe the test execution especially during
the first execution in order to prevent unintentionally long test runs.

MODEL-SIMULATOR V3.0 - User Guide
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Confirm test execution start

When starting a test group costs are incurred. You've selected 1 test(s). Do you want to

start them now?

Please see below table for possible costs. The estimations of the cloud computation
hours base on the duration of the longest running test. Due to parallelization the
computation hours are not equal to the total runtime of the tests which is significantly
less.

Runtime of longesttest = 15m 30m 1h 3h 5h

Estimated costs 1h 1h 1h 3h 5h

Fig. 3-3: Shown estimated time and estimated costs (tests tab of a project)

3322 Calculated Costs for Test executions

The MODEL-SIMULATOR costs are based on a pay-per-use concept. The cur-
rency is cloud computation hours. The costs will be calculated individually for
each test execution run. The used amount of cloud computation hours will then
be subtracted from the cloud computation hours contingent of your organ-
ization. Costs are charged in one hour steps.

The current status of cloud computation hours can be checked in the header: My
account > Cloud computation hours contingent.

More information about accounting can be found in contractual documents.

MODEL-SIMULATOR V3.0 - User Guide
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Campaigns

Campaigns define the simulation task to be applied to the model. Campaigns are
created and managed as separate elements so that they can be applied to dif-
ferent models. However, the compatibility between campaign and model must be
ensured. Campaigns contain the information how a simulation should be
executed.

The user can choose between 3 types.
— subsystem campaign: contains customer specific signals (*.mf4)

— virtual vehicle campaign: has to contain the signals vehicle target speed,
gear and road slope (*.mf4). Parameters (*.cdfx) that are optionally defined
will overwrite the parameters, which were defined within the model (CDFX
file in the simConfig folder).

— test execution campaign: contains configuration of an automated test pro-
cedure created with a test automation software e.g. ECU-TEST (*.prj)

@ Note

The compatibility of campaign and model has to be ensured by the user.

See also 3.6 "Compatibility of Campaigns and Models" on page 19.

Features Overview
The Campaigns section offers the following activities:
— Create or delete campaigns
— Edit Campaign details (campaign name, description)
— Check and refresh status of campaigns
— Search or sort campaigns

— Download stimuli files in Files tab of a campaign (see 3.9 "Upload Files Over-
view and Supported File Formats (Artifacts)" on page 21):
* measurement files as *.mf4

 parameter files as *.cdfx (only for virtual vehicle campaign)

* testunits as *.prj (only for test execution campaign)

For instructions see chapter 5 "Working with MODEL-SIMULATOR" on page 52
and subchapter 5.8 "Campaigns” on page 65.

Models

A model is a mathematical representation of a physical system. It is used to cal-
culate the resulting system behavior (model outputs) according to the fed excit-
ation signals (input stimuli). The model contains the deployables of the
simulation system (build target generated in COSYM V3.4) and some con-
figuration files, like parameters or signal filter.

MODEL-SIMULATOR V3.0 - User Guide
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In the MODEL-SIMULATOR the user can upload these models for simulation and
choose between two types: subsystem model and virtual vehicle model (see
technical details in 3.9.6 "Required Data Structure of Models" on page 28).
Whereas a virtual vehicle model has to contain the inputs vehicle target speed,
gear and road slopeModels act as individual elements and can be assigned to dif-
ferent projects, where the model can be simulated by combining with campaigns.
Once a model is uploaded in the model repository, it can be used for simulation of
different campaigns.

@ Note

The compatibility of campaign and model has to be ensured by the user.

See also 3.6 "Compatibility of Campaigns and Models" on page 19.

Real Time Factor (RTF)

The RTF is a factor that describes how fast a simulation runs in comparison to
real time. An initial value can be determined by running a simulation in COSYM and
dividing the simulation time by the duration of stimuli file.

RTF = Duration of simulation/Duration of stimuli file

Example: If the simulation time (computing time on a machine) and the duration
of stimuli file (driving time in the car) are equal and both take 1hour, the RTF
equals 1. If the simulation time takes more than the duration of stimuli file, the RTF
is greater than 1.

Duration of simulation = Duration of stimuli file = RTF = 1

Duration of simulation > Duration of stimuli file = RTF > 1

Duration of simulation < Duration of stimuli file = RTF < 1

The RTF is entered during each model upload process to display the predicted
simulation time. Therefore the determination is needed before uploading the
simulation model to the MODEL-SIMULATOR. The RTF can be changed and adjus-
ted afterwards in the model properties of a model. This change has an influence
to all projects, wherever the model is used, but no influence on running sim-
ulations.

The RTF is used to calculate the predicted simulation time by multiplying it with
the duration of stimuli file. The duration of MF4 files can be seen in the Files tab
of a campaign.

MODEL-SIMULATOR V3.0 - User Guide
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ETAS MODEL-SIMULATOR D@L | ETAS
v Campaigns >

| Type: Subsystem  Created on

Campaign details Files (2)

Length

Name Type Length Action
Trip_1
CalcSigAllDataTypes_MDF410_10sec Measurement 10s

Trip_2

< Previous page

Before a simulation starts, the predicted time is displayed in the simulations tab
of a Project. This predicted time may differ from the actual required time, depend-
ing on how valid the RTF for all stimuli files is.

The RTF depends on the complexity of the simulation model, i.e. number of ele-
ments and stiffness of the differential equation system and the number and
sampling frequency of the recorded channels. That means the lower the com-
plexity, the lower the RTF will be.

A history of the RTF with statistics can be seen in the Model properties tab in
every model. Based on run simulations a new RTF might be proposed which can
be applied easily.

@ Note

The RTF value has no influence on the real simulation duration (charged hours)
or the simulation speed. It only displays the predicted simulation time and pre-
dicted simulation costs based on the entered RTF.

Features Overview

The model repository offers the following activities:
— Create or delete models
— Edit Model details (model name, description)
— Edit Model properties (RTF)
— Checkreal time factor statistics
— Check and refresh status of models
— Search or sort models

— Download Files (see 3.9 "Upload Files Overview and Supported File Formats
(Artifacts)" on page 21):
* metadata as *.json

* model binaries/executable as *.zip

e parameter file as *.cdfx

MODEL-SIMULATOR V3.0 - User Guide
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* signal mapping file as *.smf
» datalogger configuration file as *.dIc4
* interpolation file as *.sti

For instructions see chapter 5 "Working with MODEL-SIMULATOR" on page 52
and subchapter 5.9 "Models" on page 76.

Compatibility of Campaigns and Models

The combination of campaigns and models in a project has to be compatible. The
compatibility is visualized in Fig. 3-4. Depending on model type and campaign
type different inputs and signals have to be considered. This set up can be used
for simulation or test execution use case, depending on the uploaded data.

Virtual Vehicle Model Virtual Vehicle Campaign
INPUTS SIGNALS
>vehicle target speed =~ ¢——» > vehicle target speed Powertrain System
> gear > gear
> road slope > road slope
Subsystem Model Subsystem Campaign
INPUTS SIGNALS
> customer specific «——> > customer specific Customer specific
(matching the inputs) Development Domain

(any kind of System)

Fig. 3-4: Compatibility of inputs (models) and signals (campaigns)

The suitability of each model can be identified in the "Usecase” column of the
model repository. Only the available models and campaigns are displayed in the
corresponding project types during the project creation.

ETAS MODEL-SIMULATOR D@ L | ETAS

Q Model repository

Model repository

. limit filter columns v
&b Usecase
12 3 4 55» |10 v owing 1o 10 of 2544 models (2544 total)
e~
Name S Type &  Description < Createdon $  Usecase < Status S Actions
Al

Fig. 3-5: Use case column in the model repository

MODEL-SIMULATOR V3.0 - User Guide
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Reports

Reports are used to visualize the simulation results of a project. The Reports are
created by another ETAS tool called EATB (ETAS Analytics Toolbox), which is inte-
grated in the MODEL-SIMULATOR. After finishing a simulation, the results of a
simulation group are collected to automatically generate an HTML report. That
means all simulations belonging to a simulation group have to be completed, so
that report creation starts. These automatically generated reports are named
"Default report”. Additionally, reports can be created manually with an own name
and selected completed simulation groups. Reports must be downloaded in order
to view them in the browser.

Reports are retained even if simulations are deleted, because simulation only has
to be carried out successfully once. In addition, it is also possible to create
reports manually. The reports are linked to templates on which they are based.
That means you can create report templates according to your needs.

See also 4.1 "Check System Requirements” on page 44.
For more information, especially for usage and menu description, see separate
EATB Report Guide or introduction video in the ETAS Download Center.

Report Templates

Report templates are used as a base for the report creation in a project. They
define the structure and design of the report. All templates are combined in a col-
lection and can be managed as well as uploaded in a dedicated space. The easi-
est way to create a template is using EATB.

The report template is uploaded as a ZIP file containing at least one EATB (*.eatb)
file for the different signals to be simulated and measured. The configuration file
config signals.csvOrconfig signals.mneeds to be stored inthe root
folder.

MODEL-SIMULATOR V3.0 - User Guide
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3.9 Upload Files Overview and Supported File Formats (Artifacts)

In the MODEL-SIMULATOR different data has to be uploaded for campaigns and
models. This chapter gives you an overview of all data types and the spe-
cifications.

3.9.1 Upload Files for MODEL-SIMULATOR

Object/Item Description and Content Format

Subsystem Stimuli file(s) * mf4

campaign Version 4.1, ASAM
Standard for MDF

Virtual vehicle Stimuli file(s) that contain vehicle target speed, gear *.zip
campaign and road slope.
Zip file includes subordinate campaign folder with
simulation run folders, each simulation run folder con-
tains one MF4 file (mandatory) and one CDFX file
(optional).

Test exe- ECU-Test files as a *.zip (without Report folder) that  *.zip
cutioncam-  contains at least Packages, Configurations and
paign .workspace folders.



https://www.asam.net/standards/detail/mdf/

Object/Item Description and Content Format

Models Virtual vehicle model: contains the description of the  *.zip
virtual vehicle with the inputs vehicle target speed,
gear and road slope.

Subsystem model: contains the description of a cus-
tomer specific simulation model which in con-
sequence has specific inputs.

The ZIP file consists of COSYMpr7j folder with:

> deployables as *.zip (mandatory) = cloud_deploy-
able.zip of OS folder in COSYM project

and simConfig folder with:

— signal interpolation file as *.sti (mandatory)

— datalogger configuration file as *.dlc4 (optional)
— parameter file as *.cdfx (optional)

— signal mapping file as *.smf (optional)

@ Note

A signal mapping file is only required if the labels
in the CDFX file do not match the model's
internal calibration variable names to ensure cor-
rect mapping. Otherwise, this could lead to
wrong simulation results.

Optionally the ZIP file can contain a metadata folder
to submit custom data, e.g. reason for model cre-
ation, scope, etc. with:

— metadata file as *.json

For projects only the deployables (cloud_deploy-
able.zip) in cosyMpr folder as a * zip is required.

Tab. 3-1: Upload files overview for MODEL-SIMULATOR

See also 3.6 "Compatibility of Campaigns and Models" on page 19.

3.9.2 General Conventions for Uploaded Data

Following conventions have to be fulfilled for all uploaded data in MODEL-
SIMULATOR:

— Maximum characters: 1024

— Canonly start with any
e |ower case characters

 upper case characters
e numbers

* special characters: .
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— Can contain any
* lower case characters

* upper case characters

» special characterslike: ! - . ()
— Not allowed:

» other special characters like: '

 white spaces

Due to character limitation of 140 characters for simulation group name, the
name will be truncated. Each component can be up to 44 characters long. [Cam-
paign_name]_[Folder_name]_[File_name]_[Sequence_number]

To ensure that the file name is not truncated, make sure that campaign name,
files names of *.zip and *.mf4 are not longer than 44 characters.

Used characters are shown during creation at the right edge of the text input
field.

Required Data Structure of Subsystem campaigns

In a subsystem campaign one or more stimuli files can be uploaded at once, each
as an MDF file (*.mf4) considering the ASAM Standard for MDF.

See also 3.10 "Stimuli File Requirements (*.mf4)" on page 34. For conceptual back-
ground information see 5.8 "Campaigns” on page 65.

Required Data Structure of Virtual vehicle campaigns

For the virtual vehicle campaigns a dedicated data structure has to be fulfilled for
a successful upload.

VirtualVehicleCampaign.zip |

Campaign (folder) |

Trip n (folder)

Stimuli file (mf4)
Parameter file (cdfx)

Trip n (folder)

Stimuli file (mf4)
Parameter file (cdfx)

Mf4 files and shown folder structure
are mandatory

Fig. 3-6: Virtual vehicle campaign ZIP file composition (required structure)
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A virtual vehicle campaign has to be uploaded as one ZIP file, e.g.
VirtualVehicleCampaign.zip (seeFig. 3-7). This ZIP file must contain a
superordinate folder containing one or multiple folders for each simulation run.
Each of these folder must contain an MF4 file (ASAM Standard for MDF) and can
contain a CDFX file (optionally), see in Fig. 3-8. The provided CDFX file(s) over-
write the values of the model CDFX file. If no CDFX file is provided, the parameters
are constant and taken from the model.

There are no naming conventions, but you can lean on the examples in the
screenshots. The used file names will be displayed in the Files tab of a campaign.
See also 3.9.2 "General Conventions for Uploaded Data" on page 22.

» Campaign
Name

Trip0001
Trip0002
Trip0003
Trip0004
Trip0005
Trip0006
Trip0007
Trip0008
Trip0009
Trip0010
Trip0011

Fig. 3-7: Content of campaign folder in virtual vehicle campaign ZIP file
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3.9.5

» Campaign > Trip0001
Name

|| stimulifile.mf4

1 parameterfile.cdfx

Fig. 3-8: Content of simulation run folder in virtual vehicle campaign

See also 3.10 "Stimuli File Requirements (*.mf4)" on page 34. For conceptual back-
ground information see 5.8 "Campaigns” on page 65.

Required Data Structure of Test Execution Campaigns

The ECU test tool supports external dependencies provided as part of work-
spaces. An ECU test workspace that make use of a library feature can be
uploaded via campaign services.

The use of the library feature is optional and both (with library feature and
without library feature) campaign structures are supported.

For the test execution campaign a dedicated data structure has to be fulfilled for
a successful upload.

@ Note

All the artifacts required to run the test cases must be packaged inside the
workspace. The test bench configuration (.tbc) and test configuration (.tcf)
files must contain only the relative paths to any artifacts they refer to within
the workspace. If absolute paths are provided the test case execution in the
cloud will fail.
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Campaigns Without Use of Library Feature

The ECU test data has to be zipped (without Report folder) and uploaded for the
test execution use case. At least the ZIP file must contain the packages, con-
figurations and workspace folder of the ECU test project for campaigns without
libraries.

TestExecutionCampaign.zip |

Test (folder) |

Packages (folder)

Packages (*.pkg)
Projects (*.prj)

Configurations (folder)

Testbench configurations (*.tbc)
Test configurations (*.tcf)

.workspace (folder)

Configuration files(*.xml & *.spec)

optional: further files and folders out of ECU-TEST

Fig. 3-9: Test execution campaign ZIP file composition (required structure) for
campaigns without libraries
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Campaigns With Use of Library Feature

For campaigns with libraries the following ZIP file composition has to be con-
sidered. ECU test data has to be zipped (without Report folder) and uploaded for
the test execution use case. At least the ZIP file must contain a root folder, one
or more library workspaces, a project folder with the packages, configurations
and workspace folder of the . ECU test project for campaigns with libraries.

TestExecutionCampaign.zip |

Test (folder) |

Project (folder) |

Packages (folder)

Packages (*.pkg)
Projects (*.prj)

Configurations (folder)

Testbench configurations (*.tbc)
Test configurations (*.tcf)

.workspace (folder)
Configuration files(*.xml & *.spec)

optional: further files and folders out of ECU-TEST

Library Workspace (folder) |

Packages (folder)

Packages (*.pkg)
Projects (*.prj)

.workspace (folder)

Configuration files(*.xml & *.spec)

optional: Further library workspaces can be added

Fig. 3-10: Test execution campaign ZIP file composition (required structure) for
campaigns with libraries
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3.9.6 Required Data Structure of Models

Models are represented in ZIP files with a specific data container. A dedicated
data structure has to be fulfilled for a successful upload. Depending on the use
case, the following content is required:

USE CASE IDEPENDENT TEST EXECUTION USE CASE

usable for simulation and test execution use case only usable for test execution use case

SimulationModel.zip | SimulationModel.zip |

COSYMprj (folder) | COSYMprj (folder) |
cloud_deployable.zip cloud_deployable.zip

Model binaries

Model binaries
(Build output of COSYM project in 0S

(Build output of COSYM project in OS

folder) folder)

simConfig (folder)

Signal interpolation file (sti) | optional: metadata (folder)
optional:

Parameter file (cdfx)

Datalogger configuration file (dlc4) o
Signal mapping file (smf) Model binaries and shown folder
structure are mandatory

optional: metadata (folder)

Model binaries, sti file and shown folder
structure are mandatory

Fig. 3-11: Model ZIP file composition (required structure)
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Required Data Structure of Models (Use Case independent)

A virtual vehicle model or subsystem model has to be uploaded as one ZIP file,
e.g.SimulationModel.zip (see Fig. 3-11). This model ZIP file must contain a
folder called cosyMpr7 and can contain ametadata folder (optionally). The
cosyMprj folder must contain the deployables as a ZIP (build target generated
with COSYM V3.4) and a configuration folder, which must be named simConfig
and contain an STl file. The use of SMF file is optional. This construct can be used
for projects.

The data structure of subsystem model or virtual vehicle model is the same, the
deployables are just composed differently in COSYM. In both cases COSYM cre-
atesacloud deployable.zip.Youcanenable cloud deployable creation via
View > Settings in COSYM. For more details see topics "Settings” and "Build” in
COSYM User Guide or press F1in COSYM and navigate to User Interface > Set-
tings and System Build > Build.

There are no naming conventions for the deployables, model ZIP file or con-
figuration files, but you can lean on the example in the screenshot. The used file
names will be displayed in the file information tab of a model.

See also 3.9.2 "General Conventions for Uploaded Data” on page 22.

» SimulationModel.zip

MName

COSYMprj

metadata

Fig. 3-12: Content of model ZIP file

COSYMprj
MName

simCaonfig

g cloud_deployablezip

Fig. 3-13: Content of COSYMprj folder in model ZIP file (use case independent)

» simConfig
Name

| | dataloggerconfigurationfile.dic4
E;,." parameterfile.cdfx
| | signalinterpolationfile.sti

| | signalmappingfile.smf

Fig. 3-14: Content of simConfig folder in COSYMprj folder

The simulationModel. zip contains:

> COSYMprj folder with
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— model binaries/executable as * zip, .g. cloud deployable.zip (man-
datory)

— configuration files in simConfig folder:

« signal mapping file as *.smf (optional)

@ Note

A signal mapping file is only required if the labels in the CDFX file do
not match the model's internal calibration variable names to ensure
correct mapping. Otherwise, this could lead to wrong simulation res-
ults.

 parameter file as *.cdfx (optional)
« datalogger configuration file as *.dic4 (optional)
« signal interpolation file as *.sti (mandatory)

— metadata folder



3.9.7.1

Files Specification of the simConfig Folder

Currently complex data types like maps, curves or arrays are supported, strings
are not supported.

Object/ltem  Description Format Creation Tool
Signal map- Used for calibration parameter name  *.smf Sut Mapping File
ping file mapping Version 3.10r 4.0 Editor
(optional) Only one SMF (usually comes
file, ETASspe-  WIthCOSYM
cific standarg  nstallation)
and format

@ Note

A signal mapping file is only required if the labels in the CDFX file do not match the model's
internal calibration variable names to ensure correct mapping. Otherwise, this could lead
to wrong simulation results.

Parameter file  Global parameters of the model

(optional)

Just scalar elements are supported,
<CATEGORY > type of parameter
must be therefore VALUE or BOOLEAN.
Possible types: realb4, real32, uints,
uint16, uint32, uint64, sint8, sint16,
sint32, sint64.

Example:
<CATEGORY>VALUE</CATEGORY>

* cdfx

Version 2.0,
ASAM standard
for CDF

Only one CDFX
file containing
Value or Boolean
as Category
type

COSYM, EE
(Experiment
Environment) or
other ASAM CDF
supported tool
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Object/ltem  Description Format Creation Tool

@ Note

Model's internal variable names have to match with the parameter file (*.cdfx) within the
model ZIP or in a virtual vehicle campaign you want to use for simulation.

<SHORT-NAME> tag of CDFX (within <SW-INSTANCE > block) file has to use the same name
as the label in the signal mapping file (*SUTMap Testlabel" in the SMF file).

Datalogger Signal selection for data recording, *dica EE (Experiment
configuration  this reduces the data to be processed QOnly one DLC4 Environment) —
file (optional)  and speeds up the simulation. file, ETASspe-  Datalogger tab

cific file format

Interpolation  Interpolation details variable values *.sti
file (man- Just linear or forward interpolationis  ASAM standard
datory) supported, <Interpolation value > for ST
must be therefore eLinear or eFor- Only one STl file
ward.
Example: <Interpolation xsi:-
type="InterpolationType"

value="elLinear" />

Tab. 3-2: Model ZIP file: content of simConfig folder and specifications

@ Note

If a model is simulated with a virtual vehicle campaign, the provided CDFX file of
the campaign overwrites the values of the model CDFX file.

See conceptual background information in 5.9 "Models” on page 76.

3.9.7.2  Files Description of the simConfig Folder
- <SignalMappingFileName>.smf(OpﬂOﬂa)

Signal mapping file (*.smf) is used to provide proper mapping between
labels inside the CDFX file with the model's internal calibration variable
names, if they do not match. Otherwise this could lead to wrong simulation
results.

— <ParameterFileName>.cdfx (optional):

Global parameters of model used for initialization of model variables with
predefined values.
— <DataloggerConfigurationFileName>.dlc4 (optional):

The capture of signals only with scalar data types (eBOOLEAN, e INT,
eUINT, eFLOAT) is supported by COSYM simulator (i.e X-Simulator). If the
data logger file specifies capturing of signals other than the above scalar
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data types, then simulation would result in an ERROR. If the data logger file
is not provided as part of the SUT (System Under Test) then all the signals
(as listed below) with scalar data types (eBOOLEAN, eINT, eUINT, eFLOAT)
are captured in the simulation result MF4 file.

» Allthe in-ports of the SUT

» All'the out-ports of the SUT

 Allthe characteristic and measurement variables of the SUT

The data logger file if provided must contain at least one signal to be cap-
tured as a simulation result (i.e it should have at least one entry in
<RecordingSignals>).

If the above condition is not met then that file is invalid and not supported.
The raster (i.e step size) for the recording can be configured via the task
as below:

<RecordingSignal label="..." ... task="AutoMapTaskl
10ms" ... />

All the <RecordingSignal> entries must have the same task name (i.e
task="<Task Name>")

Providing different task names for the <RecordingSignal> entries is not
supported

The task name provided in the dic4 file must be defined in the COSYM pro-
ject.

If the task is "Acquisition” (i.e task="Acquisition") then the default raster of
100 ms is considered for recording.

<SignalInterpolationFileName>.sti (mandatory):

Global mapping of simulation model inputs to stimuli file signal names (e.g.
the model uses input name A and the stimuli file use X, this must be
mapped). Within this file you can address several mapping names coming
out of different stimuli files. Time resolution in the stimuli file might be too
low with respect to the simulation model requirements, therefore the input
signals need to be interpolated to determine the stimuli file information
within a finer timescale. Usable types of interpolation are: eLinear and eFor-
ward.
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Required Data Structure of Models (Test Execution Use Case)
Regarding the test execution use case, only the deployables are required in a
dedicated data structure. This model can then be only used for projects. The
metadata folder is an optional part of the ZIP file (see Fig. 3-11in "Required Data
Structure of Models" on page 28).

» SimulationModel.zip

~

MName

COSYMprj

metadata

Fig. 3-15: Content of model ZIP file

COSYMprj
MName

E‘ cloud_deployable.zip

Fig. 3-16: Content of COSYMprj folder in model ZIP file (test execution use case)

Required Data Structure of Report Templates

The report template is uploaded as a ZIP file and can contain several EATB and M
files for the different signals to be simulated and measured. The report template
is created with the Configuration Creator in EATB. How to create a template is
described in the separate User Guide of EATB, see Chapter "Configuration
Creator”. You can also watch an introduction video, see https://www.etas.-
com/de/downloadcenter/39989.php.

For the upload, the ZIP file must contain at least one EATB file (*.eatb) and the
config signals.csvOrconfig signals.mprovided inthe root folder. The
report template has to fit to the model outputs, otherwise the report will be
empty.

> EATB_ReportTemplate v | O

L
Name

config_signals.csv
|| configuration_file.eatbh

t configuration_file.m

Stimuli File Requirements (*.mf4)

MDF (*.mf4) is a binary format (ASAM standard) used for the stimulation of a
model in the MODEL-SIMULATOR. The data is organized in data blocks. The chan-
nel group (CG) block contains channels (CN). One channel describes a recorded
signal including the encoding of the values in the records for the CG block.

MODEL-SIMULATOR V3.0 - User Guide
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The MDF format offers a wide range of possible applications. The following con-
figuration is required for uploaded MF4 files to ensure a proper data processing:

— MDF 4.x format

— time stamps always start at 0 and are not negative
— only 1channel group

— time unit is seconds

— sample rate is fixed

See more information: https://www.asam.net/standards/detail/mdf/

3.1 Overview of Status Labels

In the MODEL-SIMULATOR different status labels are defined and shown. The
tables give an overview of all status labels and their meaning.

In general there is a color coding applied.

— light blue : ready, user action needed

- : in progress, process working

- : finished, process completed

— yellow : stopped, process not completed

- : not working, something went wrong, repeat process

— grey: unavailable, process not available
There is a specific workflow followed for the status display after the simulation
has been started. This sequence is shown in the following graphic.

READY

PROCESSING

RUNNING

STOPPING

STOPPED

COMPLETED INCOMPLETE

MODEL-SIMULATOR V3.0 - User Guide


https://www.asam.net/standards/detail/mdf/

3 Basics of MODEL-SIMULATOR | 36

3.11.1 Test Execution Status

The test execution status can be found in each project in the Execution status
column of the Tests tab.

ETAS MODEL-SIMULATOR D@L | ETrs

Q Test execution projects >

o
|
db

=] Tests (5) Models (1) Project details

Type: Test execution Created on

Name Execution status (3) ~ Result status (3) Action
o Ry o100 0'5 E
nnnnn o1 @0 0's ﬁ
NNNNN ]
=2
RRRRR B
N
Labels Description
READY test execution on group, job or run level is ready to use.

PROCESSIN

test execution is going to start. Setting up a simulation can take up
some time, when a new simulation node has to be deployed.

(only for simulation
run and test exe-
cution run)

test execution on run level is running and can be stopped by user in a
certain time frame.

INCOMPLETE

At least one of the or test execution run was stopped by user, this
leads to an incomplete job.

Results of STOPPED simulations can be downloaded. It is recom-
mended to avoid too many “incomplete” jobs in projects, this can lead
to issues for report generation.

Incomplete label is also shown, if one or more runs in a job or group are
complete but none is currently running.

COMPLETED

test execution is completed.

FAILED,

test execution failed. Check files of campaign(s) and eventually start
again. Possible other reason could be cloud computation hours limit is
reached.

Tab. 3-3: Overview status labels for simulation status in projects

3N.2 Result Status in Projects
The result status can be found in each project in the Result status column of the
Tests tab.
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ETAS MODEL-SIMULATOR 9@ L | ETAS
Q Test execution projects > - -
i
| Type: Test execution Created on
rﬂ
a Tests (6) Models (1) Project details
-
Name Execution status (?)  Result status () Action
EEEEEEEEEE ese0cos [BF
nnnnn @0 @0 01 E
=) @500 005
Labels Description
N/A Test is not available due to not already started test execution. Exe-
cution status is READY .
FAILED Test is failed due to not matching conditions.
INCONCLUSIVE Trigger condition of trace analysis did not occur, no evaluation pos-
sible.
NONE No comparison of actual and expected value in the project available.
SUCCESS All test steps are passed with expected results.
ERROR Atool error occurred.
UNAVAILABLE Testis not available. See Output File Details in CLI User Guide for more

information.

3.1.3

Campaign and Model Status

The campaign, model or status can be found in the Status column of the over-
view pages or in each campaign, model.
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Labels

Description

PROCESSIN

Campaign/model is created, but some process in the background is run-
ning (e.g. unzipping of files).

Refresh and check the latest status, using the refresh button in Cam-
paigns overview or model repository.

Status 9 Actions

Crrocessi |

AVAILABLE

Campaign/model is available and ready to use for simulation.

UNAVAILABLE

Campaign/model is created, but some background processing failed
(e.g. unzipping). Campaign/model is not available and cannot be used
for simulations.

See more information in tooltips (hover over labels) inCampaigns over-
view or model repository.Check the reason for unavailability and even-
tually create a new campaign/model.

Status % Actions

Trip contains

UNAVAILABLE . | MK
invalid combination

See also 3.11.4 "Tooltips for Campaign Status” below and 3.11.5 "Tooltips
for Model Status” on page 40.

Tab. 3-4: Overview status labels for campaign/model status

31.4 Tooltips for Campaign Status

If a campaign is (BINAWAIWASIES we provide detailed information in the tooltip for
possible reasons. Hover over the label to see the details.
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Tooltip

Description and Help

<No.> of <No.> routes failed due to internal error.

Campaign could not be created. Contact
support for more details.

The campaign is unavailable because the .work-
space/Packages/Configurations/ files were not
found.

The campaign is unavailable because the Con-
figurations folder/s were not found.

Test execution campaign must contain

the following files:

— .workspace folder with configuration
files

— Packages folder with PKG and PRJ files

— Configurations folder with TBC and
TCF files

Check and see 3.9.5 "Required Data Struc-
ture of Test Execution Campaigns” on
page 25.

Stimuli length unavailable.

Check if MF4 requirements are fulfilled.

See 3.10 "Stimuli File Requirements
(*.mf4)" on page 34.

One or more files are present at a invalid path.

Invalid zip file: <filename>.zip

Trip contains non accepted files other than MF4
and CDFX.

Trip contains invalid combination.

One or more empty trips are present.

Artifacts contain invalid file formats.

Data for virtual vehicle campaign must fol-
low a dedicated structure. The folders
within the ZIP file for a virtual vehicle cam-
paign must only contain one MF4 file (Man-
datory) and one CDFX file in each folder.
Check and see 3.9.4 "Required Data Struc-
ture of Virtual vehicle campaigns” on

page 23.

Folder exists already.

There is aninternal error. Contact sup-
port to report the error, specifying the
name.
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Tooltip

Description and Help

Invalid characters in data context/Object name

There are some general conventions for
the uploaded data. This is only checked
after data upload. Ensure that the con-
ventions are fulfilled and upload the data
again.

Check and see 3.9.2 "General Con-
ventions for Uploaded Data" on page 22.

Artifacts contains invalid file formats.

Check that trips are stored in separate
folders for virtual vehicle campaigns and
each is provided with one MF4 file and
one optionally CDFX file.

See 3.9.4 "Required Data Structure of Vir-
tual vehicle campaigns” on page 23.

One or more files are present at invalid path.

MF4 and optionally CDFX files have to be
stored in folders for each trip.

Check and see 3.9.4 "Required Data Struc-
ture of Virtual vehicle campaigns” on

page 23.

3.11.5 Tooltips for Model Status

If a model is UINAVANIWASIES, we provide detailed information in the tooltip for pos-
sible reasons. Hover over the label to see the details. The combination of single
tooltips within one tooltip is possible, check separate descriptions.
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Tooltip

Description and Help

Fail to unpack the uploaded model.

Data for virtual vehicle model & subsystem model
must follow a dedicated structure. Use Winzip or
7-Zip for ZIP file creation. ZIP files created with
MATLAB" or "send to compressed folder” feature
of Windows are not working.

See 3.9.6 "Required Data Structure of Models” on
page 28 and "General Conventions for Uploaded
Data” on page 22.

Contact support for more details.

We could not find the simConfig folder.

Please add one with mandatory config
files to your model zip file.

Data for virtual vehicle model must follow a ded-
icated structure.

Check and see 3.9.6 "Required Data Structure of
Models" on page 28.

Mandatory zip file is missing.

The ZIP file for model upload must only contain
one ZIP file. This ZIP file is the target build output
of COSYM (cloud_deployable.zip).

See 3.9.6 "Required Data Structure of Models” on
page 28.

The ZIP file is present at invalid path.

The ZIP file for model upload must only contain
one ZIP file (cloud_deployable.zip) stored in the
COSYMprj folder.

See 3.9.6 "Required Data Structure of Models” on
page 28.

The SMF/CDFX file have an invalid file
path structure.

SMF and CDFX file have to be stored in the
simConfig folder.

Check and see 3.9.6 "Required Data Structure of
Models" on page 28.

Multiple SMF files are present.

Only one SMF file must be stored in the simConfig
folder.

Check and see 3.9.6 "Required Data Structure of
Models" on page 28.

Multiple CDFX files are present.

Only one CDFX file must be stored in the simConfig
folder.

Check and see 3.9.6 "Required Data Structure of
Models" on page 28.
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Tooltip

Description and Help

Multiple DLCA4 files are present.

Only one DLC4 file must be stored in the simConfig
folder.

Check and see 3.9.6 "Required Data Structure of
Models" on page 28.

Multiple ST files are present

Only one STl file must be stored in the simConfig
folder.

Check and see 3.9.6 "Required Data Structure of
Models" on page 28.

Multiple ZIP files are present.

The ZIP file for model upload must only contain
one ZIP file. This ZIP file is the target build output
of COSYM (cloud_deployable.zip).

See 3.9.6 "Required Data Structure of Models” on
page 28.

The files in the uploaded model have an
invalid file structure.

Data for virtual vehicle model & subsystem model
must follow a dedicated structure.

Check and see 3.9.6 "Required Data Structure of
Models" on page 28.

Tab. 3-5: Overview tooltips for model status

3.11.6 Tooltips for Report Template Status

If areport template is UANAZAIWAEIESR, we provide detailed information in the tool-
tip for possible reasons. Hover over the label to see the details.

Tooltip

Description and Help

Path cannot exceed 1024 characters.

The total character length must not exceed 1024.

See "General Conventions for Uploaded Data" on
page 22.

Invalid characters in data context/Object
name

There are some general conventions for the
uploaded data. This is only checked after data
upload. Ensure that the conventions are fulfilled
and upload the data again.

Check and see 3.9.2 "General Conventions for
Uploaded Data" on page 22.

The report template zip should contain at
least one EATB file.

Report template ZIP file must contain at least
one EATB file (*.eatb or *.m).

Check and see 3.9.9 "Required Data Structure of
Report Templates” on page 34.
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Tooltip

Description and Help

We found that either config_signals.csv
or config_signals.m file or both are at an
invalid path in the ZIP.

The configuration file config signals.csv
must to be stored in the root folder.

Check and see 3.9.9 "Required Data Structure of
Report Templates" on page 34.

Mandatory files are missing in the report
template. Please upload a ZIP file with
either config_signals.csv or config_sig-
nals.m file and at least one EATB file.

Report template ZIP file must contain at least
one EATB file (*.eatb or *.m). The configuration
file config signals.csv musttobe storedin
the root folder.

Check and see 3.9.9 "Required Data Structure of
Report Templates” on page 34.

The ZIP file cannot be unpacked. The
structure of the ZIP is invalid as one or
more file(s) in the ZIP contains path as
name.

Data for report template must follow a dedicated
structure. Use Winzip or 7-Zip for ZIP file creation.
ZIP files created with MATLAB® or "send to com-
pressed folder” feature of Windows are not work-
ing.

See 3.9.9 "Required Data Structure of Report
Templates” on page 34 and "General Con-
ventions for Uploaded Data” on page 22.
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Getting Started

To get started with the MODEL-SIMULATOR some preparatory actions are
required:

v User account created.

v Verification process completed.

v Authentication app is downloaded and configured (see "Set up TOTP
Authentication” on page 55).

v System requirements are fulfilled (see "Check System Requirements” below).

v’ Data preparation are fulfilled (see “Check Campaign Data" on page 48 and
"Check Model Data" on page 47).

Check System Requirements
Before starting with MODEL-SIMULATOR, be sure you meet the general system
requirements.

— Required firewall settings for general use: HTTPS traffic enabled (port TCP
443)

— Required COSYM version and license for model preparation (projects): Ver-
sion V3.4 for test execution use case

— Required Visual Studio version and license for FMUs (FMI Version 2.0): 2013
or 2017

Recommendation portable self-contained FMU without dependencies
— Required ECU-TEST version and license: V2023.2.3

For ECU-TEST project (necessary for test execution campaign used in pro-
ject) without external references to projects or packages, see

— Required EATB version and license for template creation: V5.0
— Required VLAB version and license: V2.8.3
— Required MOBI version: V5.0.1

— Recommended browser version for reports at least:
» Mozilla Firefox: v72.0.2 (64-bit)

» Google Chrome: v84.0.4147 135(64-bit)
» |atest versions of the browser are recommended

— Recommended browser version for general use:
o Mozilla Firefox: 91.8.0 (32-bit)

¢ Google Chrome: 100.0.4896.127 (64-bit)

— Recommended screen resolution: 1920x1080 (Full HD), at least 1366x768
(Wide XGA)

See also supplied Release Notes for System Requirements.
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@ Note

Check whether there are company-specific restrictions regarding upload size.
This has to be enabled by your administrator if necessary.

First Steps for Users

This chapter gives you an overview and rough information of the first steps and
how to start.

Activate your account

The activation link is sent to the registered e-mail address and valid for a limited
time frame. Set your initial password as soon as possible. If your link got invalid,
order a new one by contacting the support team or Admin User. Beside the
MODEL-SIMULATOR account you get an account for the Customer Support
Portal.

@ Note

You may check your spam e-mail folder as the registration e-mails sometimes
got there.

Sign in with multi-factor authentication

With each sign in you will receive an authentication code as time-based one-time
password (TOTP) to authenticate your user. See "Multi-Factor Authentication”
on page 55.

Welcome to the dashboard

To successfully create a project (3) we recommend to start with your model
upload (1) and your campaign creation (2).

1 — 02 — 3
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Fig. 4-1: First steps in the MODEL-SIMULATOR

Step 1: Upload your simulation model into the model repository

The model repository is a dedicated space to upload and manage all models.

You can either select a virtual vehicle or a subsystem.

Both model types require a ZIP file to be uploaded. The ZIP must include the
deployables as a ZIP and a simConfig folder including an STl file at least - both in
a folder called COSYMprj. See "Check Model Data" on the next page.

For instructions see chapter 5 "Working with MODEL-SIMULATOR" on page 52
and subchapter 5.9 "Models" on page 76.

@ Note

Only the deployables (cloud deployable.zip) can be generated with
COSYM. The overall ZIP file and the remaining files and the folder inside must be
created and added manually.

You can enable cloud deployable creation via View > Settings in COSYM. For
more details see topics "Settings" and "Build" in COSYM User Guide or press F1in
COSYM and navigate to User Interface > Settings and System Build > Build.

Step 2: Create a campaign and upload or generate your stimuli file(s)

Campaigns are used to manage simulation campaigns with individual scope.

You can either select a virtual vehicle campaign, subsystem campaign or test exe-
cution campaign according to your selected model.

A subsystem campaign requires one or more measurements files in MDF format
(*.mf4). A virtual vehicle campaign must be uploaded as one ZIP file, with a sub-
ordinate folder containing one or multiple folders for each simulation run (trip).
Each of these folders contains one stimuli file (*. mf4) and optionally one para-
meter file (*.cdfx). For the test execution campaign you need a ZIP file with your
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ECU-Test project folder, without Report folder.
For instructions see chapter 5 "Working with MODEL-SIMULATOR" on page 52
and subchapter 5.8 "Campaigns” on page 65.

Step 3: Create a project and run simulations

Projects are used to create and manage individual simulation or test execution
tasks. Assign a model and one or multiple campaigns to the project.

To assign one or multiple campaigns to a project, a new /test execution group
has to be created in the simulations/tests tab.

For instructions see chapter 5 "Working with MODEL-SIMULATOR" on page 52
and subchapter 5.7 "Projects” on page 59.

The outputs of simulations are reports (*.ntml) and simulation results (*.mf4) or
test execution results (*.zip). They can be downloaded in the reports, sim-
ulations or tests tab.

Check Model Data

Simulation models used in MODEL-SIMULATOR have to be created with COSYM
Software, V3.4 for projects). Other models cannot be processed by the applic-
ation.

Data Structure

The application expects a dedicated folder structure.
The simulationModel. zip contains:

> COSYMprj folder with

— model binaries/executable as *.zip, .g. cloud_deployable.zip (man-
datory)

— configuration files in simConfig folder:

« signal mapping file as *.smf (optional)

@ Note

A signal mapping file is only required if the labels in the CDFX file do
not match the model's internal calibration variable names to ensure
correct mapping. Otherwise, this could lead to wrong simulation res-
ults.

 parameter file as *.cdfx (optional)
« datalogger configuration file as *.dic4 (optional)
« signal interpolation file as *.sti (mandatory)

— metadata folder

For projects only the deployables (cloud_deployable.zip of COSYM) are required
in the following composition.
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USE CASE IDEPENDENT TEST EXECUTION USE CASE

usable for simulation and test execution use case only usable for test execution use case

SimulationModel.zip | SimulationModel.zip |

COSYMprj (folder) |

COSYMprj (folder) |

cloud_deployable.zip cloud_deployable.zip
Model binaries
(Build output of COSYM project in OS
folder)

simConfig (folder)

Signal interpolation file (sti)
optional:

Parameter file (cdfx)

Datalogger configuration file (dlc4) L
Signal mapping file (smf) Model binaries and shown folder
structure are mandatory

Model binaries

(Build output of COSYM project in OS
folder)

| optional: metadata (folder)

optional: metadata (folder)

Model binaries, sti file and shown folder
structure are mandatory

Fig. 4-2: Model ZIP file composition (required structure)

See also 3.9.6 "Required Data Structure of Models” on page 28 and 5.1 "Process
Steps” on page 53.

All data has to be zipped in a file for upload. You can enable cloud deployable cre-

ation via View > Settings in COSYM. For more details see topics "Settings” and

"Build” in COSYM User Guide or press F1in COSYM and navigate to User Interface
> Settings and System Build > Build.

@ Note

Only the deployables (cloud deployable.zip) can be generated with
COSYM. The overall ZIP file and the remaining files and the folder inside must be
created and added manually.

See 5.9.3 "Required Preprocessing Steps for Models” on page 78.

4.4 Check Campaign Data

Stimuli files used in MODEL-SIMULATOR have to be created in an appropriate
way. You must ensure the correct mapping of measuring channels from the time
series and the model inputs by providing an SMF file (see 4.3 "Check Model Data"
on the previous page). Deviating data cannot be processed by the application.

See also 3.6 "Compatibility of Campaigns and Models" on page 19.

4.4.7 Data Structure for Subsystem Campaign
The following dedicated requirements have to be fulfilled:
— *mf4 Version (ASAM Standard for MDF)
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After uploading the MF4 files are shown and downloadable in the Files tab of the
campaign.

Data Structure for Virtual Vehicle Campaign
The following dedicated requirements have to be fulfilled:
— *.zip contains subordinate folder with one or multiple simulation run folders

— each folder with one * mf4 (ASAM Standard for MDF) and optionally one
* cdfx file (ASAM Standard for CDF)

VirtualVehicleCampaign.zip |

Campaign (folder) |

Trip n (folder)

Stimuli file (mf4)
Parameter file (cdfx)

Trip n (folder)

Stimuli file (mf4)
Parameter file (cdfx)

Mf4 files and shown folder structure
are mandatory

Fig. 4-3: Virtual vehicle campaign ZIP file composition (required structure)

See also 3.9.4 "Required Data Structure of Virtual vehicle campaigns” on page 23
and 3.10 "Stimuli File Requirements (*.mf4)" on page 34.

@ Note

It is necessary to ensure the compatibility of the simulation model and the used
campaigns. See 3.6 "Compatibility of Campaigns and Models” on page 19

After upload the MF4 and CDFX files are shown and downloadable in the Files tab
of the campaign.

Data Structure for Test Execution Campaign

The following dedicated requirements have to be fulfilled for campaigns without
libraries:

— *zip contains a folder (e.g. Test)

— test folder contains at least Packages, Configurations and .workspace
folder of ECU-Test.
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TestExecutionCampaign.zip |

Test (folder) |

Packages (folder)

Packages (*.pkg)
Projects (*.prj)

Configurations (folder)

Testbench configurations (*.thc)
Test configurations (* tcf)

.workspace (folder)

Configuration files(*.xml & *.spec)

optional: further files and folders out of ECU-TEST

Fig. 4-4: Test execution campaign ZIP file composition for campaigns without lib-
raries (required structure)

The following dedicated requirements have to be fulfilled for campaigns with lib-
raries:

— *zip contains a folder (e.g. Test)

— *zip contains one ore more library workspace folder

— *.zip contains the folder "Project”

— Project folder contains at least Packages, Configurations and .workspace
folder of ECU test.
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TestExecutionCampaign.zip |

Test (folder) |

Project (folder) |

Packages (folder)

Packages (*.pkg)
Projects (*.prj)

Configurations (folder)

Testbench configurations (*.tbc)
Test configurations (*.tcf)

.workspace (folder)

Configuration files(*.xml & *.spec)

optional: further files and folders out of ECU-TEST

Library Workspace (folder)

Packages (folder)

Packages (*.pkg)
Projects (*.prj)

.workspace (folder)

Configuration files(*.xml & *.spec)

optional: Further library workspaces can be added

Fig. 4-5: Test execution campaign ZIP file composition (required structure) for
campaigns with libraries

The ECU test project folder can be zipped (without Report folder) and uploaded.
It is only important that the individual folders are embedded in a parent folder and
that this folder is zipped. In the Files tab of the campaign only PRJ files are shown
and downloadable.
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Working with MODEL-SIMULATOR

The Working with section provides information with focus on step-by-step
instructions as how-tos. In addition, the subchapters also contain descriptions at
the beginning.

Conceptual background of the MODEL-SIMULATOR is described in 3 "Basics of
MODEL-SIMULATOR" on page 11.

MODEL-SIMULATOR supports different tool chains and VLAB bundle versions. For
more information, see Toolchain and Tool Versions in CLI User Guide.

Toolchain Supported Tool Version Required Artifacts
Tools Version
ECUTEST + | ECUTEST 2023.2.3 | Campaign, vehicle
COSYM
COSYM 32_HF2
3.4
ECUTEST + | ECUTEST 2023.2.3 | Campaign
MOBI MOBI 5.0.1
ECUTEST + | ECUTEST 2023.2.3 | Campaign
VLAB_
VLAB_BUNDLE 1.0
BUNDLE +
MOBI MOBI 5.0.1

A VLAB bundle is a combination of a specific version of the VLAB tool and tool
boxes. The following table shows the components of VLAB_BUNDLE 1.0.

VLAB 283
can-2.5.0-win-vc140-x64.vlabtoolbox 250
rh850-3.4.4-win-vc140-x64.viabtoolbox 3.4.4
rh850-icum-3.4.1-win-vc140-x64.vlabtoolbox 3.4.1
rn850g4-icum-126.0-win 140-x64.vlabtoolbox 1.26.0

rn850g4-1.26.0-win-vc140-x64.vlabtoolbox 1.26.0



5 Working with MODEL-SIMULATOR | 53

5.1 Process Steps

The typical overall workflow is designed in the following steps.

1.

Preprocessing for models (not covered by the MODEL-SIMULATOR):
* Integrate models in COSYM V3.4 on the PC.

« Build the deployables (Target = SiL_target) in COSYM V3.4 on the PC.
(You can enable cloud deployable creation via View > Settings in
COSYM. For more details see topics "Settings” and "Build” in COSYM
User Guide or press F1in COSYM and navigate to User Interface > Set-
tings and System Build > Build.)

« Mandatory: Create the interpolation file (*.sti) with a text editor and the
sample file format, see "Create a STl File" on page 80.

 Optional: Create the signal mapping file (*.smf) with Sut Mapping File
Editor (tool usually comes with COSYM), see "Create a SMF File" on
page 81.

 Optional: Create the parameterization file (*.cdfx) with COSYM, EE
(Experiment Environment) or other ASAM CDF supported tool.

« Optional: Create the datalogger configuration file (*.dlc4) with EE
(Experiment Environment) - Datalogger tab.

« Configure the model ZIP file on the PC and check all files (see 3.9.6
"Required Data Structure of Models" on page 28).

* Integrate models in COSYM V3.4 on the PC.

Sign in to the MODEL-SIMULATOR.

Create model by uploading simulation model (see 5.9.11 "Create a Model"
on page 83).

Optional: Preprocess virtual vehicle campaign (not covered by MODEL-
SIMULATOR)

see 4.4 "Check Campaign Data” on page 48 or 3.9 "Upload Files Overview
and Supported File Formats (Artifacts)" on page 21.

Create campaign by uploading stimuli file(s) or campaign ZIP file for simu-
lation (see 5.8.9 "Create a Subsystem Campaign” on page 72, 5.8.10
"Create a Virtual Vehicle Campaign” on page 73 or "Create a Test Execution
Campaign" on page 73).

Optional: Create a report template by uploading an EATB template (if not
already available).

Create project(see "Create a Project” on page 60).

Run test execution in the project (see 5.7.11 "Run Test Executions in a Pro-
ject” on page 63).

Download test execution results (see "Download Test Execution Results”
on page 65).
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5.3
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User Interface

The user interface is divided into 4 areas:

Header (1): gives you direct access to, among others, home screen, noti-
fications of current processes or user documentation.

Breadcrumb (2): shows where you are and allows you to use for navi-
gation.

Navigation bar (3): provides you access to home (on page 57), Projects
(on page 59), Campaigns (on page 65) model repository (on page 76).

Interaction area (4): Depending on the selection in the navigation bar, dif-
ferent content is displayed and different features are available.
1

ETAS MODEL-SIMULATOR 0@ L | ETAS )

B

e
1111 B

4

Fig. 5-1: Overview of user interface areas

After signing in, you get to the home screen with your dashboard showing an
extract of the latest, projects, campaigns and models each in a separate tile.

Every menu item of the navigation bar contains the possibility to open an over-
view or to create an item according to the selection.

Input Forms

For creating projects, campaigns or models input forms are used. This supports
you to easily create items on one page. The input forms are designed similarly.
The campaigns section gives you the possibility to access the entry sections via
the summarized steps on the right instead of just scrolling down.
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5.4 Multi-Factor Authentication

The multi-factor authentication provides a secure way to sign in to the MODEL-
SIMULATOR. Every sign in you have to authenticate your user with an authen-
tication code.

That means you need a generated password in addition to the self-created pass-
word. For the authentication you need an application on your mobile phone,
mobile device or on your PC that generates a time-based one-time password
(TOTP). There are several authentication apps on the market which are working
very similar. They can be found in the internet or app stores using the keywords
"Authentication” or "TOTP" for example.

5.4.1 Set up TOTP Authentication

For setting up the time-based one-time password (TOTP) authentication the fol-
lowing workflow is designed.

STEP 1 Sign In STEP 2 Set up STEP 3 Sign In STEP 4 Enter OTP

Enter Username Scan QR Code/ Enter Username
and Password enter Secret Code and Password

Enter OTP

Enter Code

v Prerequisite: Authentication app is downloaded on mobile device or PC and
ready to use.

1. Enter username and password in the MODEL-SIMULATOR.
2. Scan QR code with the TOTP application on your device.

or
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Enter secret code in the TOTP application on your device.
= ATOTP code will be shown.

3. Enter this code in the OTP code field.
= Sign In page is shown.

4. Enter username and password .
5. Enter this code in the OTP code field.
= The MODEL-SIMULATOR dashboard is shown.

Signin via TOTP
1. Open TOTP application on PC or mobile device.
2. Goto Signin page of the MODEL-SIMULATOR.
3. Enter username and password.
4. Enter the code you received via TOTP application.
= The MODEL-SIMULATOR dashboard is shown.

Header

In the header you can check current processes (1) or open support section (2).
With the user profile symbol (3) you can change your password and sign out. The
ETAS logo brings you to the ETAS website (4), the breadcrumb (5) shows where
you are and allows you to use for navigation.

123 4
ETAS MODEL-SIMULATOR 0@ 8 | ETAS
5 ) Home
ot
E

Fig. 5-2: Overview of header areas

The header section provides you several features:
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Shows current background actions and their
progress:
e blue symbolizes an ongoing action,

ETAS MODEL-SIMULATOR Opens home section with your dashboard.

0 red symbolizes a failed action,
4 yellow shows a partly successful action,

and
e green shows a successful procedure.

By clicking on it you get more details. The num-
ber indicates number of current actions.

Opens support section with access to User
documentation, Support contact, Data pro-
tection notice, Imprint or Safety Advice and
more.

B Opens my account section where you can
change your password or sign out.

ETNS Opens ETAS website in a new tab.

Change Password
"; Quick Access:

B (header) > Change password
1. Go to My account g - Change password in the header.
= Change password site is displayed.

2. Enterrequired fields and Change password.

Home
The home section with your dashboard gives you an overview of the latest:
— Projects (1)
— campaigns (2)
— Model repository (3)
see Fig. 5-3: "Overview of dashboard (home) areas” on the next page

It shows a selection of each, within every tile you can directly jump into the sec-
tions and elements.

The dashboard combines many functionalities of the MODEL-SIMULATOR, that
means you can use it as central control and it is the fastest way to execute most
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features except simulations. Within every section you can get to the overviews or
the details of a selected item and create a project, campaign or model. Test exe-
cutions are located in a separate tab in a project.

© Home

Welcome to the dashboard

B @ 2

Projects ] Campaigns [iZl ® New test execution campaign

D
g

ws @

>
2
s

Name Type

NNNNN

il
]
f
i & & B

Model repository

z

NNNNN:

Name Type Usecase

Fig. 5-3: Overview of dashboard (home) areas

The home section provides you several features:

Opens overview of selected item (projects,
campaigns or models).

Opens detail site of selected item (projects,
campaign or model). You can also click on a
project, campaign or modelname to get to the
detail site. Afterwards you have the possibility
to edit details.

(® New project Opens project section with entry form where

you can create a new project.
SN et Opens campaigns section with entry form

where you can create a new subsystem cam-
paign. Use split button to select virtual vehicle
campaign, test execution campaign for cam-
paign creation.

& New model Opens models section with entry form where
you can create a new model.
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5.7 Projects
A Project contains the following items.

— Tests (including campaigns): show and manage tests (add, run, stop or
delete tests), see further information like execution status and result
status

— Models: show used models (type and status)
— Project details: show and edit project information

Every item can be addressed via a separate tab in an opened project.

Q Projects »

B Type: Test execution Created on
]
[=) Tests(1) = Models(1)  Project details
Name Execution status (3 Result status () Action
= ®1/00/ 00 @013
=) ®1/00/ 00 @013
Fig. 5-4: Project details (screenshot)
If you are interested in conceptual background information, check 3.3.1"Projects”
on page 12.
5.7.1 Open Projects Overview

-'; Quick Access:

Projects (navigation bar) > Projects overv/ew@

1. Goto Projects - Projects overview in the navigation bar.
= All projects are displayed.

2. Open project by clicking on name or using to get to the detail site.

5.7.2 Search Projects
-'; Quick Access:

Projects (navigation bar) > Projects overv/ew@ > [one e

1. Goto Projects - Projects overview in the navigation bar.
= All projects are displayed.
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2. Type inyour keyword into the search box (Filter projects) tofilter list
of all projects.

= All columns are searched while typing and results are displayed.
Search operators like ", *, AND, etc. cannot be used.

5.7.3 Filter Projects Overview
-'; Quick Access:

Projects =) (navigation bar) > Projects overv/ew@

1. Goto Projects —» Projects overview in the navigation bar.
= All projects are displayed.

2. Clickondropdown (Limit filter columns) to limitcolumns to which
the search filter should be applied.

= Selected columns are searched while typing and results are displayed.
Search operators like ", *, AND, etc. cannot be used.

5.7.4 Sort Projects Overview
-'; Quick Access:

Projects =) (navigation bar) > Projects overv/ew@ >

1. Goto Projects —» Projects overview in the navigation bar.
= All projects are displayed.

2. Click on column heading to sort projects ascending £ and descending =7
alphabetically or by time (column created on).
= Selected columns are sorted. When sorting, only the selected column
is considered, the other columns are neglected.

575 Create a Project
-'; Quick Access:

Projects =) (navigation bar) > New project@

1. Goto Projects - New project in the navigation bar.
= All projects are displayed.
2. Enterrequired fields:
> Project name
> Description (optional)
> Select tool chain and corresponding version
> Select model
3. Click Create.
= Projectis created and displayed on top of Projects overview.
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5.7.6 Delete a Project
-'; Quick Access:

Projects =) (navigation bar) > Projects overv/ew@ >

1. Goto Projects —» Projects overview in the navigation bar.
= All projects are displayed.

2. Click of the project you want to delete (Actions column) and confirm
dialog.
= Project containing all tests and test results will be deleted.

@ Note

If you delete an item, this has an influence to the joint use and is deleted for all
current users.

5.7.7 Delete Multiple Projects
-'; Quick Access:

Projects (navigation bar) > Projects overv/ew@ > >

1. Goto Projects - Projects overview in the navigation bar.
= All projects are displayed.

2. Select multiple projects by activating the check boxes of projects you want
to delete.

3. Click BLBEEESEEESEIN 2nd confirm dialog.

= Project containing all tests and test results will be deleted.

@ Note

You can select all projects by using the checkbox in the table
header. If you delete an item, this has an influence to the joint use
and is deleted for all current users.

5.7.8 Edit a Project
-'; Quick Access:

Projects =) (navigation bar) > Projects overv/ew@ >

1. Goto Projects —» Projects overview in the navigation bar.
= All projects are displayed.

2. Select project you want to edit by clicking on project name or using .
= Project details are opened.
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3. Goto Project details tab.

4. To adjust project name or Description select Edit.
5. Click Save.

Open Project Details
-'; Quick Access:

Projects (navigation bar) > Projects overv/ew@ >

1. Goto Projects - Projects overview in the navigation bar.
= All projects are displayed.

2. Select project you want to open by clicking on project name or using .
= Project details are opened.

3. Browse through the tabs.

Add Test Execution Group(s) to a Project
-'; Quick Access:

Projects =) (navigation bar) > Projects overv/ew@ > > Tests tab

v Prerequisite: project created. (See Create a Project)
v Prerequisite: campaign(s) created. (See "Create a Test Execution Campaign”
on page 73)

1. Goto Projects —» Projects overview in the navigation bar.

2. Select project you want to provide with test(s) by clicking on project name
or using .
= Project details are opened.

3. Goto Tests tab.

4. Click New test execution group .

= New test execution group entry form is opened.
5. Enterrequired fields:

> Test execution group name

> Description (optional)

> Select campaign(s) with double click

@ Note

You can select more than one campaign by using STRG/CTRL key and . If you

want to select all campaigns, use [E3).

6. Click Create.
= Test execution group is created and displayed on top of Tests tab.
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Run Test Executions in a Project
-'; Quick Access:

Projects =) (navigation bar) > Projects overv/ew@ > > Tests tab » E

v Prerequisite: project created. (See Create a Project)
v Prerequisite: test execution group(s) created and labeled with READY . (See
Add Test Execution Group(s) to a Project)

1. Goto Projects —» Projects overview in the navigation bar.
= All projects are displayed.

2. Select project by clicking on project name or using .

= Project details are opened. Tests tab is shown.

3. Select IE to start test execution.
= Test executionis started.

@ Note

You can also start single tests of the test execution group. Expand test exe-
cution group |+ | and click individual start button of the test level (test exe-

cution run or test execution job).

For information on status labels see 3.11.1 "Test Execution Status” on page 36 and
3.11.4 "Tooltips for Campaign Status” on page 38.

Stop Test Executions in a Project
-'; Quick Access:

Projects [iz] (navigation bar) > Projects overviewfER > W7 > Tests tab > [}

@ Note

Test executions can just be stopped within a certain time frame.

v Prerequisite: project created. (See Create a Project)
v’ Prerequisite: test execution group(s) created and labeled with [REINININER. (See
Add Test Execution Group(s) to a Project)

1. Goto Projects —» Projects overview in the navigation bar.
= All projects are displayed.

2. Select project by clicking on project name or using .

= Project details are opened. Tests tab is shown.
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3. Select E to stop selected test execution on e.g. test execution run level.

= Test execution is stopped and labeled with STOPPED , test execution
job and test execution group are labeled with
INCOMPLETE .

See also 3.11.1 "Test Execution Status” on page 36.

5.7.13 Delete a Test Execution Group in a Project
-'; Quick Access:

Projects (navigation bar) > Projects overv/ew@ > > Tests tab »

1. Goto Projects — Projects overview in the navigation bar.
= All projects are displayed.

2. Select project by clicking on project name or using .
= Project details are opened. Tests tab is shown.

3. Click of the test execution group and confirm dialog.
= Test execution group and containing test execution job(s) and test
execution run(s) as well as containing tests are deleted.

@ Note

If you delete an item, this has an influence to the joint use and is deleted for all
current users.

5.7.14 Delete a Test Execution Job in a Project
-'ﬁ Quick Access:

Projects (navigation bar) > Projects overv/ew@ > > Tests tab »

1. Goto Projects —» Projects overview in the navigation bar.
= All projects are displayed.

2. Select project by clicking on project name or using .
= Project details are opened. Tests tab is shown.

3. Expand |+ test execution group to see containing test execution job(s).

4, Click of the test execution job and confirm dialog.

= Test execution job and containing test execution runs are deleted.

@ Note

If you delete an item, this has an influence to the joint use and is deleted for all
current users.
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Delete a Test Execution Run in a Project
-'; Quick Access:

Projects =) (navigation bar) > Projects overv/em@ > > Tests tab »

1. Goto Projects —» Projects overview in the navigation bar.
= All projects are displayed.

2. Select project by clicking on project name or using .
= Project details are opened. Tests tab is shown.

3. Expand |+ test execution group and test execution job(s) to see con-
taining test execution run(s).
4, Click of the test execution run and confirm dialog.

= Test execution runis deleted.

@ Note

If you delete an item, this has an influence to the joint use and is deleted for all
current users.

Download Test Execution Results
-'; Quick Access:

Projects (navigation bar) > Projects overv/ew@ > > Tests tab »

v Prerequisite: Test execution finished and test execution group labeled with

COMPLETEDS

1. Goto Projects — Projects overview in the navigation bar.
= All projects are displayed.

2. Select project you want to open by clicking on project name or using .
= Project details are opened, Tests tab is shown.

3. Click to download the test execution result on different levels.

Campaigns
A Campaign contains the following items.
— Campaign details: show and edit campaign information
— Campaign properties: show details of testing tool (only for test execution
campaign)
— Files: show details and download files.
« parameters (*.cdfx) and measurement (*.mf4) files of a subsystem cam-

paign
« measurement (*.mf4) files of a virtual vehicle campaign

MODEL-SIMULATOR V3.0 - User Guide



5 Working with MODEL-SIMULATOR | 66

« testunit (*.prj) files of a test execution campaign

Reason for unavailability is shown.

Every item can be addressed via a separate tab in an opened campaign.

ETAS MODEL-SIMULATOR 0@ L | ETAS

Q Campaigns > HecG—-

")
B
[ avaissie | Type: Subsystem Created on:
| @
T -
Fig. 5-5: Campaign details (screenshot)
If you are interested in conceptual background information, check 3.4 "Cam-
paigns” on page 16.
5.8.1 Status Labels for Campaigns

The overview and opened campaigns show also the status:
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Label Description
AVAILABLE Campaign is created successfully and ready to use in sim-
ulations.

Campaign is created, but some process in the background is
running (e.g. unzipping of files).
Refresh and check the latest status, using the refresh button
in Campaigns overview.

Status 9 Actions

C rocessi |

CAVAVAIWAEINE  Campaign is created, but some background processing failed
(e.g. unzipping). Campaign is not available and cannot be used
for simulations.

See more information in tooltips (hover over labels) in Cam-
paigns overview. Check the reason for unavailability and create
anew campaign.

Status % Actions

Trip contains

UNAVAILABLE : L 1
invalid combination

Tab. 5-1: Overview status labels for campaigns

See also 3.11.4 "Tooltips for Campaign Status” on page 38.

Required Preprocessing Steps for Campaigns

There are 4 campaign types available in the MODEL-SIMULATOR:
— subsystem campaigns
— virtual vehicle campaigns
— testexecution campaigns

For subsystem campaigns you just have to be sure to upload MF4 files in Version
4.1 (ASAM Standard for MDF) and to meet 3.10 "Stimuli File Requirements (*. mf4)"
on page 34.
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Generated MF4 files

MF4

by ML model

Subsystem campaign Virtual vehicle campaign Test execution campaign Real-world driving campaign

ECU-Test Input

CDFX

Preprocessing Steps for Virtual Vehicle Campaigns

1. Select the stimuli files on the PC (MDF files as *.mf4, Version 4.1, ASAM
Standard for MDF).

2. Optional: Create the parameter file on the PC (*.cdfx, Version 3.1 or 4.0,
ASAM standard for CDF).

3. Configure the virtual vehicle campaign ZIP on the PC and check all files
(see 3.9.4 "Required Data Structure of Virtual vehicle campaigns” on
page 23).

Preprocessing Steps for Test Execution Campaigns
1. Create test and configuration in ECU-Test V2023.2.3.

2. Configure the test execution campaign ZIP on the PC and check all files
(see 3.9.5 "Required Data Structure of Test Execution Campaigns"” on
page 25).

ECU-Test Support and Limitations for Test Execution Campaigns

On the tool side, the MODEL-SIMULATOR supports the following features of ECU-
Test:

— ECU-Test Version: V2023.2.3
— Workspace Configuration

« Active projects (PRJ file): Use only active projects as inactive projects
are treated as active projects. If your workspace contains inactive
products delete them in ECU-Test or in the data you upload in the
MODEL-SIMULATOR. If you upload them anyway, they will be shown and
used for test execution.

ECU-Test: Project editor: Context menu > Activate
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 Referenced projects/packages (PRJ/PKG file): Use artifacts available in
workspace as external references are not supported. If you have ref-
erences linked, include them into the workspace folder you use for
upload into the MODEL-SIMULATOR. All data which should be used,
must be available in the uploaded data (self-contained).

In general the ECU-TEST-workspace has not to contain any external
links to any artifacts or to any folder (e.g. external folder for reports).

« Model access (TCF file): Use only one model file (e.g. MAPortCon-
fig.xml) and configure one model access in TCF file as multiple running
models in parallel are not yet supported. This used model has then be
also selected in the project.

ECU-Test: Test configuration editor: Platform tab > Model access
node > Model file

— Simulation Control

« Simulation Control configured in test bench configuration (TBC file):
Start and Stop properties are supported
> immediately on loading in TBC
> with running the test case
> No automatically simulation start or stop
ECU-Test: Test bench configuration editor: Select model node
(Tools and ports) > Properties window

 Multiple configuration changes in project (TBC/TCF file)
— TestResult (TRF file)

 Possible test result states (displayed in Result status column in Pro-
jects)
> SUCCESS: All test steps are passing with expected results.
> FAILED: Test is failing due to not matching conditions.
> ERROR: A tool error occured, or a test result is specified as ERROR.
> INCONCLUSIVE: Trigger condition did not occur, no evaluation pos-
sible.
ECU-Test: Package editor: Signal recordings & Trace analysis tab
> NONE: No comparison of actual and expected value in the project avail-
able.
ECU-Test: Package editor: Test case tab
We show in the Result status the label you have set in the Test step
Assertion and Test step result checkbox in ECU-Test, this test step can
be found in the Miscellaneous folder of the Default test steps folder in
the Actions window.

— Test Report (TCF file)
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 Report configuration is supported (e.g. user-defined information or fil-
ters).

» Report format: All report formats are supported with the limitation that
all formats without TRESPLITReportFormat Or only TRESPLITRe-
portFormat is working due to a ECU-Test defect (this works locally but
not on cloud).

« Collection of LOG files (Content of Messages window of ECU-Test) are
part of the generated report.

— Timing (TBC file)
In the system two clocks are used: "wall clock” time (ECU-Test) and simu-
lation time (Model). Depending on the model, the model runs faster than in
real time. That means when you use "wait" in ECU-Test, it could be the
model runs longer in simulation, because there is no synchronization. It
must be considered, that these two clocks are not synchronized.

» Using multiple measurements to check if a certain condition is fulfilled
as time synchronizationis not supported.

 Timeout of test execution (e.g. not meeting trigger condition): Take
care about timeout-configuration in ECU-Test, there is no global time-
out setting in MODEL-SIMULATOR available.

» Not supported: Time synchronization between "wall clock”-time of ECU-
Test and simulation time of simulation-ms datalogging via trigger con-
dition (via mapping file).

— Interaction of Model created in COSYM and ECU-Test

» ASAMXIL API supported (see ASAM XIL API Documentation in COSYM)
ECU-Test: Actions window: Jobs tab > Generic-XIL-API and TBC file

» Supported elements from COSYM model in ECU-Test

 Standard COSYM modules (e.g. COSYM-CCode, Simulink): All ele-
ments like Inports, Outports, Measurements and Calibration variables
are supported.

« Imported modules (e.g. FMU): Only Inports and Outports are sup-
ported.

ECU-Test: Actions window: Model access tab
See also Known Issue List in Release Notes for more specific information.

After the preprocessing you can create test execution campaigns and upload
the data to the MODEL-SIMULATOR.

MF4 File Creation Tools

MDF4 Lib and MATLAB functions can be used to generate MF4 files automatically
for Signals from Simulink. There are also tools available which record data in MDF
format.
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5.8.4 Modify Existing MF4 File
v’ Prerequisite: MDA readable tool available (e.g. ETAS MDA or ETAS ASCMO).
1. Open MF4 file.
2. Export MF4 file as ASCII.
3. Open ASCII file in Excel.
4. Change Data.
5. Import ASCI file.
6. Export selected signals as MF4.

You can also use the Calculated Signal function of MDA and extend the existing
MF4 file.

5.8.5 Open Campaigns Overview
-'; Quick Access:

Campa/gnsﬁj (navigation bar) > Overv/evv@

1. Go to Campaigns - Overview in the navigation bar.
= All campaigns are displayed.

2. Open campaign by clicking on name or using to get to the detail site.

5.8.6 Search Campaigns
-'; Quick Access:

Filter campaigns

Campa/gnsﬁj (navigation bar) > Overv/ew@ >

1. Go to Campaigns - Overview in the navigation bar.
= All campaigns are displayed.

2. Typeinyour keyword into the search box (Filter campaigns) to filter
list of all campaigns.

= All columns are searched while typing and results are displayed. Search
operators like "™, *, AND, etc. cannot be used.

@ Note

You can also search for status labels with "available” for example. See
also "Status Labels for Campaigns” on page 66 or "“Campaign and Model
Status” on page 37.

5.8.7 Filter Campaigns Overview
-'; Quick Access:

Campaigns 8% (navigation bar) » Overv/ew%
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. Go to Campaigns = Overview in the navigation bar.

= Allcampaigns are displayed.

Click ondropdown (Limit filter columns) to limitcolumns towhich
the search filter should be applied.

= Selected columns are searched while typing and results are displayed.
Search operators like ", *, AND, etc. cannot be used.

5.8.8 Sort Campaigns Overview
-'; Quick Access:

Campa/gnslﬂj (navigation bar) > Overv/evv@ > S

Go to Campaigns — Overview in the navigation bar.
= All campaigns are displayed.

Click on column heading to sort Campaigns ascending £ and descending
<7 alphabetically or by time (column created on).

= Selected columns are sorted. When sorting, only the selected column
is considered, the other columns are neglected.

5.8.9 Create a Subsystem Campaign
-'; Quick Access:

Campaignsﬁaj (navigation bar) > @ New subsystem campaign

v’ Prerequisite: Campaign data checked. (See "Data Structure for Subsystem
Campaign" on page 48.)

1.
2.

Go to Campaigns = New subsystem campaign in the navigation bar.

Enter required fields:
> Campaign name
> Description (optional)

Uploadstimuli file(s) in *. mf4 format. (See "Check Campaign Data" on
page 48 and 3.10 "Stimuli File Requirements (*.mf4)" on page 34)

@ Note

The status check and status display \ZAE[BA or JINVZAR[BY refers only to the
file format not to its content.

Click Create.
= Campaign is created and displayed in Campaigns overview. Upload
progress of files can be seen in the header.

MODEL-SIMULATOR V3.0 - User Guide



5 Working with MODEL-SIMULATOR | 73

5.8.10 Create a Virtual Vehicle Campaign
-'; Quick Access:

Campa/gnsﬂgj (navigation bar) > @ New virtual vehicle campaign

v Prerequisite: Campaign data checked. (See "Check Campaign Data" on
page 48)
1. Goto Campaigns - New virtual vehicle campaign in the navigation bar.

2. Enterrequired fields:
> Campaign name
> Description (optional)

3. Upload campaign file in *.zip format with required structure. (See "Check
Campaign Data" on page 48 and 3.10 "Stimuli File Requirements (*.mf4)" on
page 34)

@ Note

The status check and status display \AE[BA or JINVZAR[BY refers only to the
file format not to its content.

4. Click Create.
= Campaign is created and displayed in Campaigns overview. Upload
progress of files can be seen in the header.

5.8.11 Create a Test Execution Campaign
_IF Quick Access:

Campaignsﬁaj (navigation bar) » @ New test execution campaign

v Prerequisite: Campaign data checked. (See "Data Structure for Test Execution
Campaign" on page 49).
1. Go to Campaigns - New test execution campaign in the navigation bar.
2. Enterrequired fields:
> Campaign name
> Description (optional)
> Select testing tool

3. Upload ECU-Test data in *.zip format with required structure. (See "Data
Structure for Test Execution Campaign” on page 49).

@ Note

The status check and status display \AE[BE or JINVZARIBY refers only to the
file format not to its content.
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4. Click Create.
= Campaign is created and displayed in Campaigns overview. Upload
progress of files can be seen in the header.

5.8.12 Delete a Campaign
-'; Quick Access:

Campa/gnslﬂj (navigation bar) > Overv/evv@ >

1. Go to Campaigns - Overview in the navigation bar.
= Allcampaigns are displayed.

2. Click of the campaign you want to delete (Actions column) and con-
firm dialog.

@ Note

If you delete an item, this has an influence to the joint use and is deleted for all
current users.

5.8.13 Delete Multiple Campaigns
-'; Quick Access:

Campaignsﬁj (navigation bar) » Overv/ew@ > >

1. Go to Campaigns - Overview in the navigation bar.
= All campaigns are displayed.

2. Select multiple campaigns by activating the check boxes of campaigns you
want to delete.

3. Click ]E[ Delete selected

@ Note

You can select all campaigns by using the checkbox in the table
header. If you delete an item, this has an influence to the joint use
and is deleted for all current users.

and confirm dialog.

5.8.14 Edit a Campaign
-'; Quick Access:

Campa/gnslﬂj (navigation bar) > Overv/evv@ >

1. Go to Campaigns - Overview in the navigation bar.

2. Select campaign you want to edit by clicking on campaign name or using

/]
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= Campaign details are opened.

Select Edit to adjust campaign name or Description.

Open Campaign Details
-'; Quick Access:

Campaignsﬂj (navigation bar) > Overv/ew@ >

. Go to Campaigns = Overview in the navigation bar.

Select campaign you want to open by clicking on campaign name or using
/]

= Campaign details are opened.

Browse through the tabs.

Use Campaign(s) in a Project
-'ﬁ Quick Access:

Projects > Overv/ew@ (navigation bar) > > Tests tab »

(® New test execution group

v Prerequisite: project created. (See Create a Project)
v Prerequisite: test execution campaign(s) created and labeled with EAVAIFASIES
(See Create a Test Execution Campaign)

1.
2.

Go to Projects - Overview in the navigation bar.
Select project by clicking on name or using .

= Project details are opened.

Click New test execution group [[E e to add a test exe-

cution group.

= Create new test execution group entry form is opened.
Enter required fields:

> Test execution group name

> Description (optional)

Select campaign(s) with double click.

0

Note

You can select more than one campaign by using STRG/CTRL key and . If you

want to select all campaigns, use .

6.

Click Create.
= Test execution group is created and shown in Tests tab of project.
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5.8.17 Download Stimuli Files of a Campaign
-'; Quick Access:

Campa/gnsﬂgj (navigation bar) > Overv/ew@ > > Files tab »

1. Go to Campaigns - Overview in the navigation bar.
= All campaigns are displayed.

2. Select campaign you want to open by clicking on campaign name or using
A
= Campaign details are opened.

3. OpenFiles tab.

4. Expand [+ data and click B for download.

59 Models

A Model contains the following items.
— Model details: show and edit model information
— Model properties: show and edit real time factor

— Files: shows an overview of the uploaded data for the selected model.
These files can be downloaded:
« metadata (*.json)

 deployables/executable (*.zip)
« signal mapping (*.smf)

« global parameter (*.cdfx)

« datalogger configuration (*.dlc4)
« signal interpolation (*.sti)

Reason for unavailability is shown.

@ Note

Not all data may be available for download. That depends on what was
uploaded while model creation.

Every item can be addressed via a separate tab in an opened model.
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ETAS MODEL-SIMULATOR 0@ L | ETAS
Q Model repository > He—G_—
@
8 Type: Subsystem Created on ~
&b
|8 o — ——
Fig. 5-6: Model details (screenshot)
If you are interested in conceptual background information, check 3.5 "Models”
on page 16.
5.9.1 Status Labels for Models

The overview and opened models show also the status:

Label Description

Model is created, but some process in the background is run-
ning (e.g. unzipping of files).
Refresh and check the latest status, using the refresh button
in model repository.

Status 9 Actions
==

AVAILABLE Model is created successfully and ready to use in projects.

SHAWANIWNSIEZ  Model is created, but some background processing failed (e.g.
unzipping). Model is not available and cannot be used for sim-
ulations.

See more information in tooltips (hover over labels) in model
repository. Check the reason for unavailability and create a
new model.

Status % Actions

Smf file is not
UNAVAILABLE

present in vehicle

Tab. 5-2: Overview status labels for models
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See also 3.11.5 "Tooltips for Model Status” on page 40.

Use Cases

Depending on uploaded data, the following use cases are displayed in the model
repository (usecase column):

— All: *.zip with simConfig folder with SMF file and cloud_deployable.zip in
COSYMprj folder is uploaded and can be used for projects, see "Required
Data Structure of Models (Use Case independent)” on page 29.

— Test: * zip with cloud_deployable zip in COSYMprj folder (without
simConfig folder) is uploaded and can be used only for projects, see
"Required Data Structure of Models (Use Case independent)” on page 29.

— None: not usable due to incorrect data upload or missing cloud_deploy-
able.zip.

ETAS MODEL-SIMULATOR D@L | ETAS

Q Model repository

Model repository

limit filter columns v @ New model
ss Usecase
1 2 3 4 5 >>» 10 | v fowing 1 to 10 of 2544 models (2544 total)
| —
Name S Type &  Description < Created on S Usecase <  Status S Actions
a i

Hovering with the mouse over the Usecase type, the tooltip shows for which use
case this model can be used.

Real world driving
Jun 25, 2021, 10:49:18 AM Test execution Simulation

Test execution

In this example the model can only be used in a projectcombined with a test exe-
cution campaign.

Required Preprocessing Steps for Models
There are some steps required for the data you have to upload into the Model
repository.
1. Integrate models in COSYM on the PC(V3.4 for projects).
2. Build the deployables in COSYM on the PC. You can enable cloud deploy-
able creation via View > Settings in COSYM. For more details see topics

"Settings” and "Build" in COSYM User Guide or press F1in COSYM and nav-
igate to User Interface > Settings and System Build > Build.

3. Mandatory: Create the interpolation file (*.sti) with a text editor and the
sample file format, see "Create a STI File” on page 80.

4. QOptional: Create the signal mapping file (*.smf) with Sut Mapping File Editor
(tool usually comes with COSYM).
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@ Note

The Model's internal variable names have to match with the parameter
file (*.cdfx) within the model ZIP file.

<SHORT-NAME> tag of CDFX (within <SW-INSTANCE > block) file has to
use the same name as the label in the mapping file (*SUTMap Testlabel"
in the SMF file).

5. Optional: Create the parameterization file (*.cdfx) with COSYM, EE (Exper-
iment Environment) or other ASAM CDF supported tool.

6. Optional: Create the datalogger configuration file (*.dlc4) with EE (Exper-
iment Environment) - Datalogger tab.

7. Configure the model ZIP file on the PC and check all files (see 3.9.6
"Required Data Structure of Models" on page 28).

p . = ,_‘ @

Integrate Models . " . Create config
into COSYM Test & Validate Create STI file Create SMF file files in CEE
Build model
binaries STI SMF (optional) DLC4 (optional)
(cloud_deployable.zip)

CDFX (optional)

Create ZIP file
with all files

Fig. 5-7: Workflow required preprocessing steps for Models

After the preprocessing you can create and upload Models in the MODEL-
SIMULATOR.

@ Note

Only the deployables (cloud deployable.zip) can be generated with
COSYM. The overall ZIP file and the remaining files and the folder inside must be
created and added manually.

See 3.9.6 "Required Data Structure of Models” on page 28.
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5.9.4 Models in COSYM

The following workflow steps are required to build a model in COSYM. For detailed
information see seperate COSYM User Guide or press F1 within COSYM to open

the online help.

v’ Prerequisite: enable ,Create cloud deployable” via View > Settings in COSYM.

Open/create
COSYM project

(*.csp)

0 Open system
Configure 1 ’ 1
system N "
Build system )
(Target = SiL_target)

v B o e hs

cloud_deployable.zip can be

found in the OS folder of your
project directory

<Project>\Systems\System\
Configuration\0S

Fig. 5-8: Overview of steps in COSYM for model creation

595 Create a STl File

The ST file is a mandatory part of the model ZIP file (see Fig. 3-11in 3.9.6
"Required Data Structure of Models" on page 28) and refers to the ASAM

XIL standard.
1. Open a text editor.
Copy the given content below.

2
3. Enteryour values.
4

If necessary copy the SignalDescription section for each signal of the

stimuli MF4 file.

5. GotoFile > Save As and save your file as STI. (*.sti).

Save that file in the simconfig folder (see Fig. 3-11in 3.9.6 "Required Data Struc-

ture of Models" on page 28 ).
STl File Copy Content

<?xml version="1.0" encoding="utf-8"?>

<SignalDescriptionFile xmlns="http://www.asam.net/XIL/Signal/2.0"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"” xsi:schem-

alocation="http://www.asam.net/XIL/Signal/2.0 Sig-
nalDescriptionFormat.xsd" version="2.0">
<!--XIL API Signal Description File - generated by ETAS Experiment
Environment, ETAS GmbH-->

<SignalDescriptionSet name="ECS">

<!-- Beginning of paragraph <SignalDescription>. Copy for each sig-
nal. -->
<!-- Enter the <SignalDescription name and id>, <DataVectorName> and
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<interpolation value>.-->
<SignalDescription name="<!-- fill in here -->" id="<!-- fill in
here -->">
<SegmentSignalDescription>
<DataFileSegment>
<Duration xsi:type="ConstSymbol">
<Value></Value> <!-- To be filled in by MODEL-SIMULATOR -->
</Duration>
<DataVectorName><!-- fill in here --></DataVectorName>
<FileName></FileName> <!-- To be filled in by MODEL-SIMULATOR -->
<Interpolation xsi:type="InterpolationType" value="<!-- fill in
here-->" />
<Start>
<Value>@</Value>
</Start>
<TimeVectorName />
<ChannelSource />
<ChannelPath />
<GroupName />
<GroupSource />
<GroupPath />
</DataFileSegment>
</SegmentSignalDescription>
</SignalDescription>
</SignalDescriptionSet>

<!-- End of paragraph <signalDescription>. -->

<!-- Link the <SignalDescription> to the signal in the stimuli MF4
file.-->

<Assignments>

<Link key="<!-- fill in here -->" value="<!-- fill in here-->" />

</Assignments>

</SignalDescriptionFile>

STlis an XML-based data format and can be created with a text editor. See more
information about STI on ASAM website: https://www.asam.net/stand-
ards/detail/xil/

596 Create a SMF File

1. Open Sut Mapping File/SMF Editor (e.g press the Windows key and start
typing "Sut .") .
2. Configure signal mapping file.

3. GotoFile » Save As and save your file as SMF. (Smf File Version = Version
4.0, Smf File Version 3.1 = Version 3.1)

See also Sut Mapping File/SMF Editor User Guide (Help > User Guide) for more
information.

SMF is an XML-based data format, see the basic structure:

<?xml version="1.0" encoding="utf-8"?>
<SutLabelMapping xmlns:xsi= "http://www.w3.0rg/2001/XMLSchema-
instance" xmlns:xsd= "http://www.w3.org/2001/XMLSchema” ext=".smf" ver-
r="4.0" typ="SuT Mapping File">

<ToollLabellList>

<ToollLabelInfo />
<DataTypeInfo />
</ToolLabellList>
<TestLabellList>
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<TestLabelMapper />
</TestLabellList>
<HierarchylList>
<Hierarchy Path />
</HierarchyList>
</SutLabelMapping>

See one example for Signal v_TargetSpeed (SMF Version 3.1)

<?xml version="1.0" encoding="utf-8"?>
<file xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" ext=".smf"
typ="SUT Mapping File" ver="3.1" xsi:noNamespaceSchemalLocation=
"http://www.etasgroup.com/downloads/xmlns/labcar_automation/lca_smf_
v3.1l.xsd">

<!--Target Speed-->

<SUTMap TestlLabel="v_TargetSpeed" Toolla-
bel="TripAdapter/Inports/v_Stim_kmph" Hierarchy="TripAdapter" SUTType-
e="Measurement" ObjectType="Scalar" DataType="Float" Comment=" Target
Speed for Trip Adapter" Max="" Min="" Unit="" XUnit="kmph" YUnit=""/>
</file>

Open Models Overview
-'; Quick Access:

Mode/s (navigation bar) > Overv/ew@

1. Goto Models - Overview in the navigation bar.
= All Models are displayed.

2. Open model by clicking on name or using to get to the detail site.

Search Models
-'; Quick Access:

Mode/s (navigation bar) > Overv/ew@ >

1. Goto Models - Overview in the navigation bar.
= All Models are displayed.

2. Typeinyour keyword into the search box (Filter models) to filter list of
all Models.
= All columns are searched while typing and results are displayed. Search
operators like ™, *, AND, etc. cannot be used.

@ Note

You can also search for status labels with "available” or model type with
"virtual” for virtual vehicle models for example. See also "Status Labels for
Models" on page 77 or "Campaign and Model Status” on page 37.




5 Working with MODEL-SIMULATOR | 83

599 Filter Models Overview
-'; Quick Access:

Mode/s (navigation bar) > Overv/ew@

1. Go to Models - Overview in the navigation bar.
= AllModels are displayed.

2. Clickondropdown (Limit filter columns) to limitcolumns to which
the search filter should be applied.

= Selected columns are searched while typing and results are displayed.
Search operators like ", *, AND, etc. cannot be used.

5.9.10 Sort Models Overview
-'; Quick Access:

/— £
Mode/s (navigation bar) > Overv/ew@ >

1. Go to Models - Overview in the navigation bar.
= All Models are displayed.

2. Click on column heading to sort models ascending £ and descending &7
alphabetically or by time (column created on).
= Selected columns are sorted. When sorting, only the selected column
is considered, the other columns are neglected.

591 Create a Model
-'; Quick Access:

Models (navigation bar) > @ New model

v’ Prerequisite: Model data checked.

1. GotoModels - @ New model in the navigation bar.

2. Select model type. (See "Models" on page 16 for more information.)

3. Enter required fields:
> Model name
> Real time factor
> Description (optional)

4. Click Upload and select ZIP file. (See Check Model Data)

@ Note

The status check and status display \ZARIBA or INVYZARIA refers only to the
file format not to its content.
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5. Click Create.

= Modelis created and displayed in model repository when upload was
successful. Upload progress of files can be seen in the header.

5.9.12 Delete a Model
-'; Quick Access:

Mode/s (navigation bar) > Overv/eW@ >

1. Goto Models = Overview in the navigation bar.
= All Models are displayed.

2. Click of the model you want to delete (Actions column) and confirm
dialog.

@ Note

If you delete an item, this has an influence to the joint use and is deleted for all
current users.

5.9.13 Delete multiple Models
-'; Quick Access:

D
Mode/s (navigation bar) > Overv/ew@ > >

1. Goto Models = Overview in the navigation bar.
= Allmodels are displayed.

2. Select multiple models by activating the check boxes of models you want
to delete.

3. Click ]E[ Delete selected

@ Note

You can select all models by using the checkbox in the table
header. If you delete an item, this has an influence to the joint use
and is deleted for all current users.

and confirm dialog.

5.9.14 Edit a Model
-'; Quick Access:

Mode/s (navigation bar) > Overv/eW@ >
1. Goto Models = Overview in the navigation bar.

2. Select model you want to edit by clicking on model name or using .
= Model details are opened.
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3. Select Edit to adjust model name or description.
Real time factor can be edited in the Model properties tab. See also "Edit
Real Time Factor” below.

5.9.15 Edit Real Time Factor
-'; Quick Access:

Mode/s (navigation bar) > Overv/ew@ >
Based on run simulations a new RTF might be proposed which can be applied eas-
ily.
1. Go to Models - Overview in the navigation bar.
2. Select model you want to edit by clicking on model name or using .
= Model details are opened, metadata tab is shown.
3. GotoModel properties tab.

4. Select Edit to adjust real time factor.

5.9.16 Open Model Details
-'; Quick Access:

/\/lode/s (navigation bar) > Overv/ew@ >

1. Go to Models - Overview in the navigation bar.

2. Select model you want to open by clicking on model name or using .
= Model details are opened.

3. Browse through the tabs.

5.9.17 Use Model in a Project
-'; Quick Access:

Projects (navigation bar) > @ New project

v Prerequisite: project created. (See Create a Project)
v Prerequisite: model created and labeled with PAYAIFAZIRS . (See Create a
Model)

1. Goto Projects - New project in the navigation bar.

2. Enterrequired fields:
> Project name
> Description (optional)
3. Select one model with double click.

4. Click Create.
= Projectis created and displayed on top of Projects overview.
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5.9.18 Download Files of a Model
—'ﬁ Quick Access:

Mode/s (navigation bar) > Overv/ew@ > > Files tab »

1. Go to Models - Overview in the navigation bar.
= Allmodels are displayed.

2. Select model you want to open by clicking on model name or using .
= Model details are opened.

3. GotoFiles tab.

4. Clic|< for download.
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Troubleshooting

What is the difference between a virtual vehicle model and
a subsystem model?

A virtual vehicle model represents a powertrain system and
hence expects the specific inputs vehicle target speed, gear
and road slope. A subsystem model can represent any kind of
system.

Read more "Models" on page 16 and "Compatibility of Cam-
paigns and Models" on page 19.

What is a multi-factor authentication? Why do | need that?

To ensure a secure sign in into the MODEL-SIMULATOR we use
a multi-factor authentication concept. This means only you can
sign in with your username, password and a code received by an
authentication application on your mobile device or computer.

Read more "Multi-Factor Authentication” on page 55.

Why does my password need to have 20 characters?

In general a password is better the longer it is. A password of 20
characters or more is considered to be secure.

More information "Change Password" on page 57.
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Contact Information

Technical Support

For details of your local sales office as well as your local
technical support team and product hotlines, take a look at
the ETAS website:

www.etas.com/hotlines
ETAS offers trainings for its products:

www.etas.com/academy

ETAS Headquarters

ETAS GmbH
BorsigstraBe 24 Phone: +497113423-0
70469 Stuttgart Fax: +49 711 3423-2106

Germany Internet: www.etas.com
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Glossary

This glossary contains abbreviations and explanations of special terms that are
important.

Campaign
A campaign is based on one or many stimuli files, which are used to feed the
inputs of the simulation model. In the MODEL-SIMULATOR 3 types are select-
able: subsystem campaign, virtual vehicle campaign and test execution cam-
paign.
See 3.4 "Campaigns” on page 16.

CDFX

Calibration Data Format (ASAM standard), created with e.g. COSYM, EE (Exper-
iment Environment) or other ASAM CDF supported tool and used to para-
meterize the models. It can be part of a virtual vehicle campaign or of a model
(configuration files) and must be created and added manually.

See 3.4 "Campaigns” on page 16 and 5.9 "Models" on page 76.

It stores calibration parameters of different data types, the physical values

and unit. The XML-based format can be easily validated, edited, imported and
exported by calibration tools and XML editors.

DLC4 (ETAS specific file format)
Datalogger configuration, created with e.g. EE (Experiment Environment),
which is used to limit signals for data recording. The file can be used to reduce
processing time, only the listed signals will be part of the simulation result
instead of all. It can be part of a model (configuration files) and must be cre-
ated and added manually.
See 3.5 "Models" on page 16 and 3.9 "Upload Files Overview and Supported File
Formats (Artifacts)" on page 21.

Home/dashboard

The dashboard is the starting point in MODEL-SIMULATOR and gives an over-
view of latest projects, campaigns and models. You can create projects and
campaigns or upload models.

MF4/MDF

Measurement Data Format (ASAM standard) used for time series data, e.g.
simulation data results or input stimuli. It is part of a campaign.
See 3.4 "Campaigns” on page 16.

Model
A model is a mathematical representation of a physical system.
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It calculates the resulting system behavior (model outputs) according to the
fed excitation signals (input stimuli). In the MODEL-SIMULATOR two types of
model can be uploaded: subsystem model and virtual vehicle model.

While a subsystem model can represent any kind of system, a virtual vehicle
model represents a powertrain system, hence expects the specific inputs
venhicle target speed, gear and road slope.

Model repository

The model repository is a dedicated space to upload and manage all models in
the MODEL-SIMULATOR.

Real time factor (RTF)
The RTF is a factor that describes how fast a simulation runs in comparison to
real time. An initial value can be determined by running a simulation in COSYM
and dividing the simulation time by the duration of stimuli file. RTF = Duration
of simulation/Duration of stimuli file
See 3.5.1"Real Time Factor (RTF)" on page 17.

SMF (ETAS specific file format)
Signal mapping file, created with e.g. Sut Mapping File Editor (usually comes
with COSYM) and used for global mapping of vehicle model variables to stimuli
file signal names. It can be part of a model (configuration files) and must be
created and added manually.
See 3.5 "Models" on page 16 and 3.9 "Upload Files Overview and Supported File
Formats (Artifacts)" on page 21.

The XML-based format can be edited by an XML editor.

STI
Generic Simulator Interface (ASAM standard), Interpolation file, created with
e.g. EE (Experiment Environment) and used to interpolate input signals. It
must be part of a model (configuration files) and must be created and added
manually.
See 3.5 "Models" on page 16 and 3.9 "Upload Files Overview and Supported File
Formats (Artifacts)" on page 21.

Stimuli files
Stimuli files are needed to feed the model inputs and thus needed to starta
simulation. In the MODEL-SIMULATOR it can be measurement files as *. mf4
(subsystem campaign) or the combination of measurement files as *. mf4 and
parameter files as *.cdfx in folders within a ZIP file (virtual vehicle campaign).
See 3.4 "Campaigns” on page 16.

Subsystem campaign
A subsystem campaign is a campaign based on one or many measurement
files (*.mf4).
See 3.4 "Campaigns” on page 16 and 3.9 "Upload Files Overview and Supported
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File Formats (Artifacts)" on page 21.

Subsystem model

A subsystem model represents a part of the vehicle in form of a simulation
model and can be used to represent any kind of system.
See 3.5 "Models" on page 16.

Test execution campaign

A test execution campaign is a campaign based on configured testunits cre-
ated with ECU-Test. These tests are defined by packages/projects, con-
figurations, data bases, utilities, test reports and configuration files handled in
a workspace.

See 3.4 "Campaigns” on page 16 and 3.9.4 "Required Data Structure of Virtual
vehicle campaigns” on page 23.

Virtual vehicle campaign

A virtual vehicle campaign is a campaign based on one or many trips (simu-
lation runs). These trips are defined by one stimuli file (*. mf4) and one para-
meter file (*.cdfx), whereas the stimuli files have to contain vehicle target
speed, gear and road slope.

See 3.4 "Campaigns” on page 16 and 3.9.4 "Required Data Structure of Virtual
vehicle campaigns” on page 23.

Virtual vehicle model

A virtual vehicle model can be used to represent a whole vehicle in form of a
simulation model with respect to a development domain like powertrain.
See 3.5 "Models" on page 16.
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